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Chapter 

1 Configuration  
 

Software Configuration Flow Chart 

 

Page 19 Log In ID : admin, without password and 
Enter 

 

Page 19 Database – Area/Floor 
Definition Define Area/Floor Definition 

 

Page 21 Set Up  - Port Definition 

Define the serial ports used on each 
PC and the network connection if 
you use LAN communication and 
the Dial Up connection if you use 

Dial Up communication. 

 

Page 23 Set Up – Controller 
Definition 

Define each controller address and 
information on the system 

 

Page 55 Set Up – Dial Up Chain 
Definition 

If you defined to use Dial Up 
communication on the second step, 
you should set up this step. If you 

are not, go to next step. 

 

Page 25 Set Up – Door/Reader 
Definition 

Define Door/Reader information for 
each controller on the system. 
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Page 66 Set Up – Map Definition 

Define Map Definition for each 
Area/Floor if you want to use it. You 
can define Door and Sensor. (Before 

you define sensor, you should go 
Set up – Input/Output Point Set up – 
Input/Output Definition. After that you 

should set up sensor) 

 

Page 45 
Set Up – Input/Output Point 

Set up – Input/Output 
Definition 

If you use other devices (like sensor, 
exit button, etc) on the input, you can 

set up this step. 

 

Page 49 
Set Up – Input/Output Point 

Set up – Input/Output 
Timeschedule Definition 

If you want to define operation time 
for the input and output using 

timeschedule, you can set up this 
step. 

 

Page 60 Database – Company 
Definition Define Company List 

 

Page 81 Access Control – Holiday 
Definition Define Holiday 

 

Page 86 
Access Control – 

Timeschedule Definition – 
Time zone Definition 

Define Time zone 

 

Page 90 
Access Control – 

Timeschedule Definition – 
Timeschedule Definition 

Define Timeschedule 
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Page 96 Access Control – Access 
Group Definition Define Access Groups 

 

Page 101 Access Control – Card 
Holder Management Define Card Holder Management 

 

 Configuration Completed  
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Chapter 

2 
  STARWATCH iTDC PRO 
Introduction  

 

STARWATCH iTDC PRO I Introduction 

This chapter explains iTDC main functions and installation environment. 
 
STARWATCH iTDC PRO I Main Functions  

This program connects the iTDC controller and PC via Serial and TCP/IP communication to send 
and receive data.  It uses the data received to run its many functions. 

The device and program are mutually connected to provide access control for higher security.  It 
also has a variety of applied additional functions to manage access control.  The user’s event data 
can be used as basis for time attendance reporting, as well as access control in corporate 
environments. 

• Multi Port  Support 

This configuration can be applied from address 01 up to 99.  Using Serial or TCP/IP 
communication, you can connect up to 99 communication loops. One port can connect up to 
32 devices (change of communication chip expands to 255 devices).  However, if you go over 
the fixed number of devices in a communication loop, the PC resources may not support the 
setup.  Use the port to gain the best possible communication management depending on the 
environment. 

• Multi Language Support 

Multi Language support has two main languages as default (Korean, English).  Additionally, 5 
other languages are supported through user’s input.  Using a separate multi language 
definition program, the user can change the English characters into their own language as 
default to use the STARWATCH iTDC PRO I in their own language. 

• Card Holder Management Function Combinations 

Card Holder Management gives you the user’s basic information (name, company, dept, etc.) 
in addition, access group and time attendance data , fingerprint data can be input and modified 
in one screen. 

Also, registration and deletion date can be scheduled for automatic deletion on set date. 

Specific user can be deleted through card holder management, and can be recovered later on 
by managing separately.  The deleted user current status can be known. 

• Deleted User Managing Function 

The deleted user from card holder management is processed separately, and can be 
recovered to put into normal status, without any need to reenter the user data.  Also, deleted 
user’s current status can be seen as a report by making an inquiry. 
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• Visitor Management Function 

Visitor management is processed by identifying the user as non regular card holder.  Visitor’s 
data contains company, name, reason for visit, visitor, visiting dept.  Access area and time can 
be controlled by access group. 

Automatic delete function through specific date and time registered will erase card number.  
Also, visitor’s current status can be seen as a report by making an inquiry. 

• Map Function 

Map can be setup using area and floor as basis to the corresponding floor.  Door and sensors 
are shown as icons, and depending on user options, the time of day when an event occurs will 
be shown automatically on the map. 

• TCP/IP and Serial Communication Simultaneous Support 

Using multi port function, network and serial communication can be activated simultaneously.  
Set port 1 as serial and port 2 as network configuration to activate simultaneously using both 
ports. 

• Alarm Event Acknowledgement 

Using Alarm Event Acknowledgement, when an event occurs, the manager can input detail of 
information to acknowledge the alarm. 

All alarm events must be acknowledged by the manager to have the alarm event cancelled.  
The acknowledged result is stored in database for later retrieval as a report. 

• Alarm Event Type Color Indication 

Using color to differentiate alarm event type gives easy monitoring in one screen.  The alarm 
event acknowledged by the manager is shown in black. 

• Various Access Control Reports 

The program contains reports of card holder, deleted user, access current status, alarm 
current status, visitor current status, user permitted per authorized door, individual permitted 
door, and final access area giving variety of access control reports. 

• Work Attendance and Various Related Reports 

Work attendance management function is included in basic form, therefore a separate 
program is not necessary. 

Individual work hour and holiday setup is possible.  You can configure expiration for date, 
month, and year to support report retrieval by making an inquiry for work hour data. 

Using the work hour data, you can calculate work hour, tardiness, leave of absence, overtime, 
holiday/weekend overtime, days worked, days of tardiness, and days of leave absence. 

User can modify the user data to reflect on expiration day, month, and year after the final 
worker ends the shift for the day. 
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All work hour data can be sent to Excel file or text file to be used in other applications such as 
ERP. 

Reports support type by individual, day, month, month detail, yearly, and can be converted to 
look like HTML, PDF, and Excel format. 

• Various Export and Converting Function 

ITDC supports export and converting function through inquiry and report function. 

The file is sent as text or Excel format.  In this case, connecting the file to other applications 
(time attendance, wage, and ERP) can be efficient. 

In converting function, the report is converted to Excel, HTML, and PDF in its original form.  In 
this case, the file can be converted to be sent to the internet and email for data report transfer. 

• Various Options 

User can setup various options. 

You can setup event type indication, and saved database existence.  By setting up .wav file for 
each event type, you can have an alarm event sound. 

Also, when an event occurs, email dispatch function can be used if email server is present at 
location.  Email dispatch will be sent out to up to 3 people in matters to alarm event current 
status. 

Map indication existence can be setup by event type. 

• Uniformed User Interface 

User interface is uniformed by, using an icon for each function with one click operation for 
overall ease of use without difficulty.  Also, button key by menu type and function can be setup 
to operate function at once. 

 

 

 

STARWATCH iTDC PRO I Installation Environment 

Operating System 

STARWATCH iTDC PRO I is a 32 bit Windows compatible S/W.  It operates in Windows98SE, 
Windows 2000 Professional, Server Edition and higher versions, along with Windows XP Home 
and Professional Edition. 

STARWATCH iTDC PRO I does not support Windows 95, 98, ME, and NT 4.0. 

It is recommended the STARWATCH iTDC PRO I to be installed in Windows 2000 Professional or 
Windows XP Professional.  These operating systems are powerful and stable for STARWATCH 
iTDC PRO I operations. 
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Minimum Configuration 

Minimum configuration is no more than 10 panels and 40 readers for the system.  One or two port 
usage is suitable.  Maximum users of no more than 100-200 users recommended in configuration.  
Memory expansion improves system functions therefore, having more memory is beneficial. 

 CPU: Pentium III-700 Mhz or  Higher 

 Memory: 128 Mb or Higher 

 HDD: 2 Gig. 

 Port: 2 serial port or Higher 

 Network: 1 ethernet card 

 OS: Microsoft Windows 2000 Professional or Windows XP Home 

Recommended Configuration 

Recommended configuration is no more than 60 panels and 240 readers for the system.  Four port 
usage is suitable.  Maximum users of no more than 500 users recommended in configuration.  In 
this case, it is good to have a separate PC to operate independently.  It is recommended to use 
general PC mfrs and servers matching configurations below.  Memory expansion improves system 
functions therefore, having more memory is beneficial. 

 CPU: Pentium 4 or Higher 

 Memory:  256 Mb or Higher 

 HDD:  4 Gig or Higher 

 Port:  4 serial port (Needs Multi Port card)  or Higher 

 Network:  1 ethernet card 

 OS: Microsoft Windows 2000 Professional or Windows XP Professional 

Performance Configuration 

Performance configuration is no less than 60 panels and 240 readers for mid to large size system.  
Also, 8 ports or no less is suitable for operation.  Maximum users of no less than 500 users 
recommended in configuration.  In this case, it is good to have a separate PC to operate 
independently.  It is recommended to use general PC mfrs and servers matching configurations 
below.  Memory expansion improves system functions therefore, having more memory is beneficial. 

 CPU:  Pentium 4  or Dual processors. 

 Memory:  512 Mb or Higher 

 HDD:  8 Gig or Higher 

 Port:  8 serial port (Needs Multi Port card)  or Higher 

 Network:  1 ethernet card 

 OS:  Microsoft Windows 2000 server or Windows XP Professional 
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Other Configuration (Network, Modem) 

Besides using serial communication, iTDC can use TCP/IP and Dial Up using a modem for 
communications. 

In TCP/IP communication, there is an external converter (NetEye 1000S) or an internal module on 
the main board (Optional) giving you 2 types of converters. 

To use TCP/IP communication, you will need either an external converter or internal module, and 
the PC have to be able to use the network. 

If using a modem, you need to use an external modem.  For assurance of tech support and device 
compatibility, we recommend 3 COM’s US Robotics 56K External Modem or NetComm 
(http://www.netcomm.com.au/) Roadster V92 External Modem. 

For detailed explanation regarding TCP/IP and modem communication, please refer to chapter 7 
(TCP/IP communication) and chapter 8 (Dial Up communication).  

 



 
 
 
 
 
 

™STARWATCH ITDC PRO I  

 11                                               

Chapter 

3   STARWATCH iTDC PRO I 
Installation Environment 

 

STARWATCH iTDC PRO I™ Introduction 
This chapter explains STARWATCH iTDC PRO I installation. 
 
Installation Preparation 

Operating System 

The following is the STARWATCH iTDC PRO I installation OS. 

Microsoft Windows 2000 Professional Edition (SP2) 

Microsoft Windows 2000 Server Edition (SP2) 

Microsoft Windows XP Home Edition 

Microsoft Windows XP Professional Edition 

Also, it is not necessary, but we recommend installing Internet Explorer 6.  If you do not have this 
browser, you can download at Microsoft Web Site. 

http://www.microsoft.com/downloads/search.aspx?displaylang=en 

Microsoft Office 2000 Program 

STARWATCH iTDC PRO I uses the Microsoft Access 2000 database within the Microsoft Office 
2000 application. 

Microsoft Office 2000 program is not necessary, but for database and user operation, it makes it 
convenient.  (Microsoft Office XP installation works the same) 

Installation is recommended, if program is obtained. 

STARWATCH iTDC PRO I Installation 

Find the iTDC.msi file in the software CD and click it to initialize its installation. 

1)  As the following window shows on the screen, click “Next” in order to star the installation 
process. 

http://www.microsoft.com/downloads/search.aspx?displaylang=en
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2) Click “Next” to install it in the default directory. In order to change its install directory, click” 
Browse” and choose a folder to install the iTDC software.  

  

3) Click “Next” to start its process. 

 

4) During the process it shows its status. Please wait. 



 
 
 
 
 
 

™STARWATCH ITDC PRO I  

13 

 

5) If completed, it shows as below. Click “ Close” to finish it. 

   

You may see the following message during the installation process in Microsoft Windows 
2000 or Window XP 
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In this case, just click “ Continue” in order to complete the installation.   

After completion of its installation, please find MDAC_TYP of the language of the 
OS(Window) that used now. 
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Chapter 

4 
 STARWATCH iTDC PRO I 
Structure 

 

STARWATCH iTDC PRO I Structure 

This chapter explains STARWATCH iTDC PRO I structure.  It explains main 
screen structure, menu, standard icon, directory, and database file. 
 
iTDC Main Window 

iTDC main screen is differentiated into 4 parts. 

Top section consists of menu and tool bar, and middle contains screen activated by function.  
Bottom section shows status, and through the main screen, the user can initiate functions quickly 
and efficiently. 

 

 

 

 

 

Status Icons
The date of computer, time and 
language selected currently etc. are 
shown. And log-in ID of log-in user 
is shown. 

Program Area 
The screen of function selected 
in menu or short cut icon is 
shown in program practice 
area. The functions users want 
is executed through this area. 

Short Cut Icon
Function used frequently is able to 
be practiced at once by setting up 
short cut icon. 

Title Bar and Menu 
Menu which allows to 
practice title of program 
and/or all functions of  
iTDC is existed. Able to 
practice only by 
contracted key, for that 
contracted key is set up 
at each menu.(contracted 
key table reference)  
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Title bar and Menu 

Title bar and Menu 

 

Title bar shows program title and current version. 

Menu is categorized into 8 sections.  Each menu contains sub-menus, which the user can activate 
functions by selecting the correlating sub-menu. 

Menu Structure and Short Cut Key 

 System 

It contains functions for communication relation, device definition, dial up setup, system log on 
(off), and quit. 

 

System Shortcut 
Key 

System   ALT + S 

 Port Definition  CTRL + A 

 Panel Definition  CTRL + B 

 Door/Reader Definition  CTRL + C 

 Input/Output Definition Input/Output Point Definition CTRL + E 

  Input/Output Timeschedule/Type Definition CTRL + F 

 System Set Time CTRL + G 

  Set Initialize CTRL + H 

 Dial-Up Chain Definition  CTRL + I 

 Logon  CTRL + J 

 Logoff  CTRL + K 

 Quit  CTRL + Q 
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 Database 

Database contains definition for company, department, title, area setup, map setup, user 
registration, management and options.  Inputting the default user data will be used in user 
management.  It also contains map function to setup by area and floor.  Database management 
contains backup, recovery, and compression for data. 

 

Database Short Cut Key 

Database   ALT + D 

 Company Definition  CTRL + L 

 Department Definition  CTRL + M 

 Title Definition  CTRL + N 

 Access Type Definition  CTRL + O 

 Area/Floor Definition  CTRL + P 

 Map Definition  CTRL + R 

 User Definition  CTRL + S 

 Database Management  CTRL + T 

 Option  CTRL + U 

 

 

 Access Control 

Access Control menu contains sub functions for managing access control.  It contains setup for 
work holiday, time schedule, user group, user management, and visitor management. 

 

Access Control Short Cut Key 

Access Control   ALT + A 

 Holiday Definition  F2 

 Timeschedule Definition Time Zone Definition F3 

  Timeschedule Definition F4 
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 Access Group Definition  F5 

 Card Holder Management  F6 

 Deleted Card(ID) Management  F7 

 Visitor Management  F8 

 

 View 

View menu contains access door control status, event transaction status, and communication 
status to monitor functions. 

 

View Short Cut Key 

View   ALT + V 

 Access Door Control/Status  CTRL + F1 

 Transaction Status  CTRL + F2 

 Communication Status  CTRL + F3 
 Event Status Windoe   
 Video Surveillance   

 

 

 Report 

Report menu contains sub-menus for various reports.  You can have 8 types of access control 
reports. 

 

Report Short Cut Key 

Report   ALT + R 

 Card Holder Report  CTRL + F4 

 Deleted Card Holder Report  CTRL + F5 

 Event History Report  CTRL + F6 

 Alarm History Report  CTRL + F7 

 Accessible Door Report for 
Individual 

 CTRL + F8 

 Accessible ID Report  for Door  CTRL + F9 
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 Visitor Event History Report  CTRL + F11 

 Last Access Event Report  CTRL + F12 

 

 Time & Attendance  

Time & Attendance menu consists of sub-menus relating to the time attendance with the 
system.  It contains definition for work time, work holiday, work type, data (daily, monthly, 
yearly) expiration, report, and work options to operate functions easily. 

 

Time / Attendance Short Cut 
Key 

Time/Attendance   ALT + T 

 Work Time Definition  SHIFT + F2 

 Work Holiday Definition  SHIFT + F3 

 Work Type Definition  SHIFT + F4 

 Daily Data Management  SHIFT + F5 

 Monthly Data Management  SHIFT + F6 

 Yearly Data Management  SHIFT + F7 

 Report ID/Daily Attendance Report SHIFT + F8 

  Monthly/Yearly Attendance Report SHIFT + F9 

 Work Option  SHIFT + F11 

 

 Window 

Window menu gives you options for horizontal or vertical viewing in a row. 

 

 

 

Window 

Window  

 Horizontal 

 Vertical 

 Language 

Language menu contains multiple languages to change language of program for user. 
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Language 

Language  

 Korean 

 English 

 User Language 1 

 User Language 2 

 User Language 3 

 User Language 4 

 User Language 5 

 

Shortcut Icon 

Shortcut icon lets the user perform frequently used functions to quickly initiate jobs.  

The black label to the right of shortcut icons displays current activity data of program operation. 

 

Here are the types of shortcut icons. 

Short Cut Icons 

 
Time Zone Create access time code and access time setup. 

 
Timeschedule Setup time schedule by day of the week access time code. 

 
Access Group Create group in access area. 

 
Card Holder Input, edit, and delete card holder data. 

 
Visitor Input, edit, and delete visitor data. 

 
Transaction Monitor current event transaction in real time. 

 
Door Control Monitor door control status and manual control doors. 

 
Map Definition Setup item location and area/floor map definition. 

 
Report Access control report inquiry and print out report. 

 
Language Language setup. 

 
Logoff Logoff from program. 
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Quit Quit program 

 

Status bar 

Status bar displays current date and time setup in PC.  Also, it displays current language and user 
login ID. 

 

Standard Icon 

It explains standard icons used in iTDC.  You  can see general icons in every screens of iTDC.  
These icons perform their specified functions.  The following explains each icon’s function. 

 

Standard Icon 1  

 
Find Finds the data by search condition. 

 
Add Used for adding data and activates additional screen. 

 
Modify Used in modifying data and activates modify screen. 

 
Delete Used in data deletion and deletes the data. 

 
Close Closes the current active screen. 

 

                       

Standard Icon 2 

 
Transmit Sends the current selected data to the device (iTDC) 

 
Batch Transmit Sends the searched data and database info in batch format. 

 

 

Standard Icon 3 

 
Create Data Creates information result with original data. 
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Standard Icon 4 

 
Print Searched information is printed out. 

 
Export Exports searched information text as Excel file format. 

 

Program Folder 

It explains the folder where STARWATCH iTDC PRO I is installed. 

STARWATCH iTDC PRO I is installed in C:\Program Files\iTDC folder.  Also, depending on 
circumstance, it is installed in C:\Program Files\idteck\iTDC. 

User can change the drive and folder, where program is installed.  During installation, it 
can install to other drive and folder if default folder is not used. 

Database Structure 

STARWATCH iTDC PRO I has 3 database files in structure, and all database file is created in 
Microsoft Access 2000 file. 

The following is the database file creation. 

 iTDC-ACS.mdb 

This database file contains all saved information of device data, user data, event current alarm 
data, and is the main database file of STARWATCH iTDC PRO’s access control system. 

This file is the most important database file, and needs user’s management.  Refer to 
maintenance management chapter for detailed explanation. 

 iTDC-TAS.mdb 

This database file is STARWATCH iTDC PRO’s attendance file, and contains all saved 
information of time attendance, work holiday, work type, end of (day, month, year). 

This file is most important database file in attendance function, and needs user’s management. 

 iTDC-LANGUAGE.mdb 

This multi language database file in STARWATCH iTDC PRO I contains all characters 
information displayed on screen in saved files. 
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Initial Setup 

 

STARWATCH iTDC PRO I Initial Setup 

This chapter explains installation items setup, after installing STARWATCH 
iTDC PRO. 
 
Program Login 

The following screen appears in initial program activation.  Login gives program use 

authorization, and if this is first time login after installation, you will need to use default login 

information.  

 

 

 
Once the login screen appears, input admin for User ID. Password is without. Then press 

Enter or click Login button to go to main screen. 

 
Program Configuration 

Area/Floor Definition 

Area/Floor configuration is used for default data creation to distinguish access door, reader, and 
sensors by installed locations.  Multiple buildings can be designated by area, and the floors correlating 
to the area can be distinguished. 

 Start 

Click Database->Area/Floor definition or press Ctrl+P on keyboard. 

 Add 

Add is used to create fresh data.  Click Add to input data of area and floor through the input 
screen. 

 23                                               
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1) Click Add and the screen below appear. 

  

2) Input area code.  If already registered code is used, it will not register, but only a fresh area code. 

3) Input area name. 

Select floor then click Add button.  It will show up in Floor List window.  Repeat this procedure to 
add additional floors. 

4) If all the floors are added to the area, click Save button to save. 

5) Click Close to finish. 

Setup the area/floor definition prior to use, because the data is used in variety of ways for 
registration of access door, reader, input point of contact, and map configuration.  
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Port Definition 

Port definition describes Serial and TCP/IP communication loop connected to the PC.  It supports up 
to 99 ports, but keep in mind depending on PC performance, memory, and OS, supporting 99 ports 
may not be possible.  It is recommended to use adequate number of ports for usage. 

 Start 

Click Set up-> Port Definition or press Ctrl+A button on keyboard. 

 Add 

Add is used to create fresh data.  Click Add to add ports through the input screen. 

  

1) Click Add and the screen below appear. 

  

2) Select port number.  It will indicate port numbers not used. 

3) Select communication type by Serial Chain, TCP/IP Chain, or Dial-Up Chain to setup 
communication. 

4) Check mark Active for the correspond port to be able to communicate. 
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Decide if correspond port will be active for communication.  Active check mark Port No 
communicates, but without a check mark will result in no communication. 

This option lets the user make the port inactive, if the port requires maintenance due to a 
problem in communication.  User can fix the problem while other locations remain with active 
ports. 

If the port data is modified, you must close the program and restart. 

5) From Serial Chain tab, select Com Port, Speed, Parity Bit, Data Bit, and Stop Bit.  Set the value 
as 9600 for Speed, none for Parity Bit, 8 for Data Bit, and 1 for Stop Bit as iTDC default set value. 

6) Selecting TCP/IP Chain tab will change the screen as follows. 

  

In the IP address window, input the address of the external or internal TCP/IP converter. 

Input 5000 as default value for TCP Port No. 

For Module Type, select internal or external (Neteye 1000s) as converter type. 

7) Selecting Bypass TCP/IP Chain tab will change the screen as follows. 

  

In the IP address window, input the IP address of the Webeye Controller. 
Input ‘80’  as default value for TCP Port No. 

Input admin ID(Default : admin). Input admin password (Default : admin).  
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Select com port of webeye controller. Com port is port no. of webeye is connected with iTDC 
controller. 

Select Speed, Parity Bit, Data Bit, and Stop Bit.  Set the value as 9600 for Speed, none for Parity 
Bit, 8 for Data Bit, and 1 for Stop Bit as iTDC default set value. 

8) Click Save to save the port data input, and click Close to finish. 

For detailed explanation of TCP/IP communication, please refer to chapter 7 (TCP/IP 
communication) in STARWATCH iTDC PRO.  Also, refer to chapter 8 regarding Dial-Up 
communication in STARWATCH iTDC PRO. 

 

Panel Definition 

Panel Definition explains data definition of iTDC board. 

Each iTDC device has its own communication address.  By address type, the S/W data is defined and 
communicated.  Also, each iTDC can have its own function options, and these options is sent to the 
devices for application. 

 Start 

Click Set up->Panel Definition or press Ctrl+B button on keyboard. 

 Add 

1) Add is used to create fresh data.  Click Add to add panels through the input screen 

 

2) Click Add and the following screen appear. 
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3) Select Port No.  It will display the port numbers from port registration. 

4) Panel numbers not registered will be displayed in Unregistered Panel No. List.  Select the Panel 
No. to register by clicking >> button or double clicking the panel number to add to the right hand 
side Registered Panel No. List window. 

Panel registration must be done one at a time.  This means after registering one panel 
number, you need to input the panel’s default data.  Once this is done, click Save button to 
save this panel’s definition to finish.  Repeat the procedure to add additional panels. 

5) Select Panel Type as iTDC. 

6) Select Door Type as 2 Door, 3 Door, or 4 Door for operation. 

7) Input Panel Name.  It must be done because it is used to locate which panel is having the event 
when an event occurs. 

8) Card memory definition is setup.  The event memory is automatically defined depending on card 
memory.  Define adequate card and event memory for operation. 

9) Panel Default value is optional (It is not necessary for operation) 

10) Click Save button to save data. 

11) Click Close button to finish. 
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Biometrics Reader Definition 

Biometrics Reader Definition explains data definition of biometrics reader (FGR006, FINGER006).  
Each Biometrics Reader has its own communication address over 100.  By address type, the software 
data is defined and communicated for biometrics data.  Also, each biometrics reader can have its own 
function options, and these options are sent to the biometrics reader for application. 

 Start 

Click Set up->Biometrics Reader Definition or press Ctrl+C button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

1) Select Loop No. and Biometrics Reader No. as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, it will display the results. 

 

If find has no specific parameters, it will display the entire information  
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 Add 

Add is used to create fresh data.  Click Add button to add data through input screen. 

 

a. Click Add button, and the following screen appear. 

 

b. Select Loop No.  It displays only the Loop No. that was registered in Loop Definition. 
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c. Unregistered Biometrics Reader No. List displays items not selected from Loop No.  Select the 
Controller No. to be registered choosing and clicking >> button or double click the Controller No. 
to select, and it will show up on the right hand side Registered Controller No. List.  

Biometrics Reader registration must be done one at a time to setup.  

It will register one biometrics reader number with its basic data for configuration.  Click Save 
button to complete the process. 

Repeat the procedure to add additional biometrics readers. 

d. Select Biometrics Reader Type. 

e. Input Reader Name.  This is a must in order to define the location, when an event occurs to a 
Controller. 

f. Configure Biometrics Reader Function.  Each functions is explained in H/W manual 

2) Click Save button to save data. 

3) Click Transmit button to send setup data to biometrics reader. 

4) To change a master card, Input a master card no. to change. Click Change button. 

When setup is performed for all biometrics reader, software, and related data, it is not active 
until transmitted to biometrics.  It is possible the transmit function may not work properly.  

Complete all initial setup and reboot the software, and make certain communication is 
established before using transmit function. 

5) Click Close button to finish. 

 

 

 

 

 

 

 

 

 Modify 
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Modify is used to change existing data inputted.  Find data to modify or to change registered 
biometrics reader category. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Modify to see the following screen.  The Modify is equal to registration screen.  However, the 
Loop No. cannot be changed, and modify is possible to the selected one Controller address. 

 

Modify the items that need changing. 

2) Click Save button to save the modified information.   
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3) Click Transmit button to send setup data to biometrics reader. 

When setup is performed for all biometrics reader, software, and related data, it is not active 
until transmitted to biometrics.  It is possible the transmit function may not work properly.  

Complete all initial setup and reboot the software, and make certain communication is 
established before using transmit function. 

4) Click Close button to finish. 

 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered 
biometrics reader category data. 

Selected data is displayed as below figure in high-lighted blue bar. 

  

1) Click Delete button.    Click Yes button to delete or No button to cancel. 

 

 

 

 

 Transmit 
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This function is used to send the setup functions to the biometrics reader for activation.  Use Find 
to search for data transmit or select the data from the registered biometrics reader categories to 
send. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Transmit button.  This will send the selected data to the corresponding biometrics reader No. 
for application. 

 

 

 

 

 

 

 

 

 

Door/Reader Definition 

Door/Reader definition explains door and reader data.  Door and reader are connected to each iTDC 
Controller.  Therefore, software needs to be defined regarding the door and reader data to control 
event occurrence and iTDC controller. 
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 Start 

Click Set up->Door/Reader Definition or press Ctrl+C button on keyboard. 

 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

1) Select Loop No. and Controller No. as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 

 

 

 

 Add 

Add is used to create fresh data.  Click Add to add Door/Reader data through the input screen. 
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1) Click Add button and the following screen appear. 

 

2) Select Loop No. and Controller No.  Once Controller No. is selected, depending on door type 
definition, it will display as above example of 2 Door tabs (Access door 1, Access door 2) 

In 3 Door definition, it will display tabs (Access door 1, Access door 2, Access door 3) 

In 4 Door definition, it will display tabs (Access door 1, Access door 2, Access door 3, Access door 
4) 

3) Anti-Passback is configured. (For detailed explanation, refer to chapter 4 initial setup) 

4) Input Door Info with area, floor, and name.  Area and floor data is according to current installed 
access doors. (Configure the area/floor of access door through Database->Area/Floor Definition) 
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For Door Name, input easily identified name for definition. 

5) Access door contact type and lock type is optional. 

6) Select Duress Mode if to be used, and input a 2-digit password to use Duress. 

7) Input data for Reader (In) and Reader (Out). 

For Reader Name, input easily identified name for definition. 

For Reader Mode, select whether using card ID or card + password for operation.  (You will need 
keypad reader to use this setup). For all time schedules upon selecting card + password 
selection, you can configure to use depending on time to use card ID or card + password in 
specified time to change automatically. (This function is connected to time schedule for detailed 
explanation, refer to chap. 4) 

Configure Reader (In) and Reader (Out), if using 1 access door with 2 readers as In and Out, 
but if using only 1 reader, configure Reader (In) only. 

If using 2 doors, configure In and Out reader or In only for all doors. 

If using 3 doors, 1 door can be configured as In and Out reader, and the 2 doors as In reader 
only. 

If using 4 doors, all doors are configured as In reader only. 

8) Use the above method to configure each door (Access door 1, Access door 2, Access door 3, and 
Access door 4) information for operation. 

9) Click Save button to save. 

10) Click Close button to transmit setup data to iTDC controller. 

When setup is performed for all controller, software, and related data, it is not active until 
transmitted to Controller.  It is possible the transmit function may not work properly.  

Complete all initial setup and reboot the software, and make certain communication is 
established before using transmit function. 

11) Click Close button to finish.  

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
reader category. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Modify to see the following screen.  The Reader/Door Definition is equal to registration 
screen.  However, the Loop No. and Controller No cannot be modified. 

 

2) Modify category that needs changing.  Once completed, click Save button to save modified data. 

3) Click Transmit button to send setup data to iTDC Controller. 

When setup is performed for all controller, software, and related data, it is not active until 
transmitted to Controller.  It is possible the transmit function may not work properly. 

Complete all initial setup and reboot the software, and make certain communication is 
established before using transmit function. 



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

39 

  

4) Click Close button to finish. 

 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered data. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Delete button.    Click Yes button to delete or No button to cancel. 

 

 

 

 

 

 

 Transmit 

This function is used to send the setup functions to the iTDC controller for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 

Selected data is displayed as below figure in highlighted blue bar. 
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2) Click Transmit button.  This will send the selected data to the corresponding Controller No for 
application. 

During transmit, if errors do not occur, there are no messages.  This means the transmit was 
completed without disruption. 

If an error does occur, detailed explanation is displayed in a message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
iTDC Controller for problems. 
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Chapter 

6 
 STARWATCH iTDC PRO I 
Access Control 

 

TARWATCH iTDC PRO I Access Control 
 
This chapter explains specific instructions on Access Control functions 
in STARWATCH iTDC PRO. 

System 

System contains communications, iTDC device, and directly related functions.  Configurations are 
setup for communication port, device data, reader, door, and various data.  Also, the setup values are 
sent to the iTDC panel for application. 

System related functions are to precede after device and S/W initial installation, and these functions 
are not used frequently, but plays a critical part during initial setup. 

Port Definition 

Port definition describes Serial and TCP/IP communication loop connected to the PC.  It supports up 
to 99 ports, but keep in mind depending on PC performance, memory, and OS, supporting 99 ports 
may not be possible.  It is recommended to use adequate number of ports for usage. 

 Start 

1) Click Set up-> Port Definition or press Ctrl+A button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Select Port No and Comm Type as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

Find, Add, Modify, Delete functions are all applied equally in input/output screen.  Once you 
familiarize these functions, you can easily understand them as they are used equally in other 
input/output screens. 

 Add 

Add is used to create fresh data.  Click Add button to add work type data through input screen. 

 

 

 

6) Click Add button, and the following screen appear. 
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7) Select Port No and it will indicate Port No not used.  The Port No already in use is not displayed. 

8) Select Comm Type as Serial Chain for Serial, TCP/IP Chain for TCP/IP, and Dial-UP Chain for 
Dial-Up as communication type. 

9) Check mark Active for the correspond port to be able to communicate. 

Decide if correspond port will be active for communication.  Active check mark Port No 
communicates, but without a check mark will result in no communication. 

This option lets the user make the port inactive, if the port requires maintenance due to a 
problem in communication.  User can fix the problem while other locations remain with active 
ports. 

If the port data is modified, you must close the program and restart. 

10) Select from Serial Chain tab, Comm Port, Speed, Parity Bit, Data Bit, and Stop Bit.  The default 
value is Speed 9600, Parity Bit None, Data Bit 8, and Stop Bit 1 for configuration. 

11) Input screen changes if TCP/IP Chain is selected. 

 

Input the IP Address from the external converter or internal converter for configuration. 

Input TCP Port No as default value 5000. (Port No is fixed at 5000) 
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Select Module Type as internal or external version. 

For detailed instructions on TCP/IP communication, refer to chapter 7 STARWATCH iTDC PRO I 
TCP/IP Communication. 

12) Selecting Bypass TCP/IP Chain tab will change the screen as follows. 

  

In the IP address window, input the IP address of the Webeye Controller. 
Input ‘80’  as default value for TCP Port No. 

Input admin ID(Default : admin). Input admin password (Default : admin).  

Select com port of webeye controller. Com port is port no. of webeye is connected with iTDC 
controller. 

Select Speed, Parity Bit, Data Bit, and Stop Bit.  Set the value as 9600 for Speed, none for Parity 
Bit, 8 for Data Bit, and 1 for Stop Bit as iTDC default set value. 

13) Click Save to save the port data input, and click Close to finish. 

 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered work 
time category. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Modify to see the above screen.  The Port List is equal to registration screen.  Therefore, the 
Port No cannot be changed. 

 

2) Modify the items that need changing.  Once completed, click Save button to save the modify data.  

3) Click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered category 
list data. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

Deleting the registered port will erase all data of panel, access door, and reader.  Please use 
extreme caution when using this function 
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Panel Definition 

Panel Definition explains data definition of iTDC board.  Each iTDC device has its own communication 
address.  By address type, the S/W data is defined and communicated.  Also, each iTDC can have its 
own function options, and these options is sent to the devices for application. 

 Start 

Click Set up->Panel Definition or press Ctrl+B button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

3) Select Port No and Panel No as appropriate. 

4) Click Find to make an inquiry.  If inquired result is available, it will display the results. 

If find has no specific parameters, it will display the entire information  

 Add 

Add is used to create fresh data.  Click Add button to add work type data through input screen. 
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1) Click Add button, and the following screen appear. 

 

2) Select Port No.  It displays only the Port No that was registered in Port Registration. 

3) Unregistered Panel No. List displays items not selected from Port No.  Select the Board No to be 
registered choosing and clicking >> button or double click the Board No to select, and it will show 
up on the right hand side Registered Panel No List.  
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Panel registration must be done one at a time to setup.  

It will register one panel number with its basic data for configuration.  Click Save button to 
complete the process. 

Repeat the procedure to add additional panels. 

4) Select Panel Type as iTDC. 

5) Select Door Type as 2 door, 3 door, or 4 door for operation. 

6) Input Panel Name.  This is a must in order to define the location, when an event occurs to a panel. 

7) Configure card memory.  Depending on card memory setup, the event memory is automatically 
setup.  Configure adequate amount of card and event memory. 

8) Default Panel value is optional.  It is not necessary for operation. 

9) Click Save button to save data. 

10) Click Transmit button to send setup data to panel. 

When setup is performed for all device, program, and related data, it is not active until 
transmitted to panel.  It is possible the transmit function may not work properly.  

Complete all initial setup and reboot the program, and make certain communication is 
established before using transmit function. 

11) Click Close button to finish. 

 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered panel 
category. 

Selected data is displayed as below figure in highlighted blue bar. 
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5) Click Modify to see the following screen.  The Panel Modify is equal to registration screen.  
However, the Port No cannot be changed, and modify is possible to the selected one panel 
address. 

 

Modify the items that need changing. 

6) Click Save button to save the modified information.   

7) Click Transmit button to send setup data to panel. 
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When setup is performed for all device, program, and related data, it is not active until 
transmitted to panel.  It is possible the transmit function may not work properly. 

Complete all initial setup and reboot the program, and make certain communication is 
established before using transmit function. 

8) Click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered panel 
category data. 

Selected data is displayed as below figure in highlighted blue bar. 

  

2) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

Deleting the registered panel will erase all data of panel, access door, and reader.  Please 
use extreme caution when using this function. 

 Transmit 

This function is used to send the setup functions to the iTDC device for activation.  Use Find to 
search for data transmit or select the data from the registered panel categories to send. 
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Selected data is displayed as below figure in highlighted blue bar. 

  

3) Click Transmit button.  This will send the selected data to the corresponding Panel No for 
application. 

During transmit, if errors do not occur, there are no messages.  This means the transmit was 
completed without disruption. 

If an error does occur, detailed explanation is displayed in a message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
iTDC panel for problems. 

 

 

 

 

 

 

Biometrics Reader Definition 

Biometrics Reader Definition explains data definition of biometrics reader (FGR006, FINGER006).  
Each Biometrics Reader has its own communication address over 100.  By address type, the software 
data is defined and communicated for biometrics data.  Also, each biometrics reader can have its own 
function options, and these options are sent to the biometrics reader for application. 

 Start 
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Click Set up->Biometrics Reader Definition or press Ctrl+C button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

5) Select Loop No. and Biometrics Reader No. as appropriate. 

6) Click Find to make an inquiry.  If inquired result is available, it will display the results. 

 

If find has no specific parameters, it will display the entire information  

 

 

 Add 

Add is used to create fresh data.  Click Add button to add data through input screen. 
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a. Click Add button, and the following screen appear. 

 

b. Select Loop No.  It displays only the Loop No. that was registered in Loop Definition. 

c. Unregistered Biometrics Reader No. List displays items not selected from Loop No.  Select the 
Controller No. to be registered choosing and clicking >> button or double click the Controller No. 
to select, and it will show up on the right hand side Registered Controller No. List.  
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Biometrics Reader registration must be done one at a time to setup.  

It will register one biometrics reader number with its basic data for configuration.  Click Save 
button to complete the process. 

Repeat the procedure to add additional biometrics readers. 

d. Select Biometrics Reader Type. 

e. Input Reader Name.  This is a must in order to define the location, when an event occurs to a 
Controller. 

f. Configure Biometrics Reader Function.  Each functions is explained in H/W manual 

14) Click Save button to save data. 

15) Click Transmit button to send setup data to biometrics reader. 

16) To change a master card, Input a master card no. to change. Click Change button. 

When setup is performed for all biometrics reader, software, and related data, it is not active 
until transmitted to biometrics.  It is possible the transmit function may not work properly.  

Complete all initial setup and reboot the software, and make certain communication is 
established before using transmit function. 

17) Click Close button to finish. 

 

 

 

 

 

 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
biometrics reader category. 

Selected data is displayed as below figure in highlighted blue bar. 
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9) Click Modify to see the following screen.  The Modify is equal to registration screen.  However, the 
Loop No. cannot be changed, and modify is possible to the selected one Controller address. 

 

Modify the items that need changing. 

10) Click Save button to save the modified information.   

11) Click Transmit button to send setup data to biometrics reader. 
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When setup is performed for all biometrics reader, software, and related data, it is not active 
until transmitted to biometrics.  It is possible the transmit function may not work properly.  

Complete all initial setup and reboot the software, and make certain communication is 
established before using transmit function. 

12) Click Close button to finish. 

 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered 
biometrics reader category data. 

Selected data is displayed as below figure in high-lighted blue bar. 

  

3) Click Delete button.    Click Yes button to delete or No button to cancel. 

 

 Transmit 

This function is used to send the setup functions to the biometrics reader for activation.  Use Find 
to search for data transmit or select the data from the registered biometrics reader categories to 
send. 

Selected data is displayed as below figure in highlighted blue bar. 
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4) Click Transmit button.  This will send the selected data to the corresponding biometrics reader No. 
for application. 

 

 

 

 

 

 

 

 

 

Door/Reader Definition 

Door/Reader definition explains door and reader data.  Door and reader are connected to each iTDC 
Controller.  Therefore, software needs to be defined regarding the door and reader data to control 
event occurrence and iTDC controller. 

 Start 

Click Set up->Door/Reader Definition or press Ctrl+C button on keyboard. 
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 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

3) Select Loop No. and Controller No. as appropriate. 

4) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create fresh data.  Click Add to add Door/Reader data through the input screen. 
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12) Click Add button and the following screen appear. 

 

13) Select Loop No. and Controller No.  Once Controller No. is selected, depending on door type 
definition, it will display as above example of 2 Door tabs (Access door 1, Access door 2) 

In 3 Door definition, it will display tabs (Access door 1, Access door 2, Access door 3) 

In 4 Door definition, it will display tabs (Access door 1, Access door 2, Access door 3, Access door 
4) 

14) Anti-Passback is configured. (For detailed explanation, refer to chapter 4 initial setup) 

15) Input Door Info with area, floor, and name.  Area and floor data is according to current installed 
access doors. (Configure the area/floor of access door through Database->Area/Floor Definition) 
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For Door Name, input easily identified name for definition. 

16) Access door contact type and lock type is optional. 

17) Select Duress Mode if to be used, and input a 2-digit password to use Duress. 

18) Input data for Reader (In) and Reader (Out). 

For Reader Name, input easily identified name for definition. 

For Reader Mode, select whether using card ID or card + password for operation.  (You will need 
keypad reader to use this setup). For all time schedules upon selecting card + password 
selection, you can configure to use depending on time to use card ID or card + password in 
specified time to change automatically. (This function is connected to time schedule for detailed 
explanation, refer to chap. 4) 

Configure Reader (In) and Reader (Out), if using 1 access door with 2 readers as In and Out, 
but if using only 1 reader, configure Reader (In) only. 

If using 2 doors, configure In and Out reader or In only for all doors. 
If using 3 doors, 1 door can be configured as In and Out reader, and the 2 doors as In reader 
only. 
If using 4 doors, all doors are configured as In reader only. 

19) Use the above method to configure each door (Access door 1, Access door 2, Access door 3, and 
Access door 4) information for operation. 

20) Click Save button to save. 

21) Click Close button to transmit setup data to iTDC controller. 

When setup is performed for all controller, software, and related data, it is not active until 
transmitted to Controller.  It is possible the transmit function may not work properly.  

Complete all initial setup and reboot the software, and make certain communication is 
established before using transmit function. 

22) Click Close button to finish.  

 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
reader category. 

Selected data is displayed as below figure in highlighted blue bar. 
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5) Click Modify to see the following screen.  The Reader/Door Definition is equal to registration 
screen.  However, the Loop No. and Controller No cannot be modified. 

 

6) Modify category that needs changing.  Once completed, click Save button to save modified data. 

7) Click Transmit button to send setup data to iTDC Controller. 

When setup is performed for all controller, software, and related data, it is not active until 
transmitted to Controller.  It is possible the transmit function may not work properly. 

Complete all initial setup and reboot the software, and make certain communication is 
established before using transmit function. 
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8) Click Close button to finish. 

 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered data. 

Selected data is displayed as below figure in highlighted blue bar. 

  

2) Click Delete button.    Click Yes button to delete or No button to cancel. 

 

 

 

 

 

 Transmit 

This function is used to send the setup functions to the iTDC controller for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 

Selected data is displayed as below figure in highlighted blue bar. 
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5) Click Transmit button.  This will send the selected data to the corresponding Controller No for 
application. 

During transmit, if errors do not occur, there are no messages.  This means the transmit was 
completed without disruption. 

If an error does occur, detailed explanation is displayed in a message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
iTDC Controller for problems. 

 

 

 

 

 

In/Output Definition 

In/Output Definition configures signal activation for specific outputs when an input signal occurs.  It 
also sets how long in seconds the output signal will activate.  

It is also possible to setup a user preferred text display, when an input signal type occurs. 

Depending on In/Output panel door type setup, the data in reference to In/Output signal using iTDC 
default value is automatically created and stored in the database.  For this reason, the user does not 
have to Add or Delete, but the In/Output signal, activated time, and point of input can be modified and 
transmitted. 
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There is not add/delete function for input/output point information. 

Input/Output data are automatically selected based on door type entered from panel set up.  

Because this data is registered by default setting value of iTDC, user dose not need to add or 
delete data. Only modification is available to change setting value of input/output and 
download modified data to control iTDC. . 

Input/output data in selected iTDC are automatically deleted when user deletes panel from 
panel setting. 

Refer hardware manual to setting default value for input/out based on door type. 

 Start 

Click Set up->Input/Output Definition List or press shortcut key Ctrl+E. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

1) Select Port No and Panel No as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available it will display the results. 
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If find has no specific parameters, it will display the entire information 

 Modify 

Input/Output Point is automatically setup in default value depending on door type.  However, if the 
user modifies the Input/Output status, you can activate the Point differently.  

Select the Input Point of the panel to be modified.  Selected data is highlighted.  

 

1) Click Modify button. 

1) Input Point sets which outputs of the iTDC board will occur from receiving the input signal from the 
iTDC board. 

Also, when an Input Point type and corresponding Input Point occurs, the text display and 
specified time of signal occurrence success or failure can be setup. 
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2) Select Area and Floor Location.  Selecting the location of input signal occurrence lets the user 
check where the event location occurred. 

3) For Input Point name, input the letters displayed in the event window that corresponds to the input 
signal occurrence. 

4) Decide which outputs will activate in Output 1-15, when an input signal occurs.  The input value 
for the Output is setup in seconds. 

00 sec for input will result in no signal for the corresponding output.  Selecting from 01-99 sec will 
let the output activate for specified seconds. 

5) Click Save button to save. 

6) Click Transmit to send to iTDC device. 

When setup is performed for all device, program, and related data, it is not active until 
transmitted to panel.  It is possible the transmit function may not work properly. 

Complete all initial setup and reboot the program, and make certain communication is 
established before using transmit function. 

7) Click Close button to finish. 

Normal setting defines input form other devices which are connected to iTDC and which 
output is activated based on input type which means input type can be changed by user. 
However, some of specific setting input values are fixed as exit and door contact depends on 
door type. (Refer hardware manual for detail) 

Advanced set-up dose not accept signal from other devices selected by user. Because 
advanced set up is fixed for internal input signal, specific value must be received.    

Therefore, Input type or name can not be entered when user modifies advanced set up.  
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Modification of advanced set up allows changing output type and activation time based on 
input signal 

 

 

 

 

In/Output Timeschedule & Signal Type 

Configures Time Schedule of Input/Output Point activation.  This is connected to the Time Schedule, 
and the user can modify the signal occurrence of Input/Output Point. 

Basically, iTDC create signal for all inputs when it receives input signal. Moreover iTDC create 
output signal when any output signal is received.  

However, input and output signal can be controlled by timeschedule. User may be able to 
activate input/output only based on time schedule. 

This function applied for connecting sensor in case of input, for connecting door lock in case 
of output. 

If you connect the sensor in specific input relay, it occurred event anytime, day and night 
detecting the situation. 

This case, surplus of event cause slowing the processing, which cause that the useless 
information would be stored. 

If you set the time schedule for input point connected sensor, like 08:00~18:00 which not 
works during set time. Sensor works during 18:01~07:59. Except above time , the event will 
not occurred ,even the sensor works. 

Incase of output, if you connect the door lock to certain output, depending on the output 
status, which keep the continuously lock or release. 

But in working hours (like day time), you can set up the open the door, after working hours, 
dawn, automatically keep the close the door, if the registered card is presented the door once 
open. 

In case output, within the time schedule, keep unlock, except this time, keep the lock the door. 

 Start 

Click Set up->Input/Output Definition List or press shortcut key Ctrl+E. 

 Find 
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Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

1) Select Port No and Panel No as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available it will display the results.  

If find has no specific parameters, it will display the entire information 

 Modify 

Select the Input Point of the panel to be modified.  Selected data is highlighted. 
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1) Click Modify button. 

  

2) Clicking the DropDownCombo of corresponding Input Point will display the contents setup in Time 
Schedule.  Select the time schedule to apply. 

Default value for Time schedule content means it will not be applied.  However, when an input 
occurs the signal is taken care of at that moment with a resulting event occur. 

3) Click Save button to save. 

4) Click Transmit button to send to iTDC device. 

When setup is performed for all device, program, and related data, it is not active until 
transmitted to panel.  It is possible the transmit function may not work properly. 

Complete all initial setup and reboot the program, and make certain communication is 
established before using transmit function. 

5) Click Close button to finish. 

Output Point Time Schedule setup method and Input Point setup method is identical. 
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Clicking the Dropdown Combo of corresponding Input Point will display the contents setup in 
Time Schedule.  Select the time schedule to apply, then click Save and Transmit button to 
configure. 

You can configure signal handling method of iTDC, if the Input Point Type connected input 
devices (Exit, Contact, Sensor, etc..) signal is NO or NC. 

 

Clicking the Dropdown Combo of corresponding Input Point will display the NO and NC 
contents.  Select the value to apply then click Save and Transmit button to configure. 

 

 

System Management (Set Date&Time) 

This function resets the device clock and date in iTDC.  In general, initial installation of iTDC result in 
incorrect time data.  Use this function to modify date and time. 

 Start 
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Click Set up->System Management->Set Time or press shortcut key Ctrl+G. 

 Setup 

 

1) Change Date, Week, and Time value.  (Displayed default value is time and date of PC based) 

2) Select System List to define which iTDC device to Transmit to. 

3) Click Transmit button to complete setup. 

System Initialize 

This function is used to setup default status for all stored data or specified part in iTDC device. 

System Initialize is differentiated as System Initialize, Card Data Initialize, Event Data Initialize, and 
Time Schedule Initialize. 

 System Initialize: Setup of all stored data in iTDC to default value. 

 Card Data Initialize: Setup of stored card data in iTDC to default value. 

 Event Data Initialize: Setup of stored event data in iTDC to default value. 

 Time Schedule Initialize: Setup of stored time schedule and work holiday data in iTDC to 
default value. 

 Start 

Click Set up->System Management->System Initialize or press shortcut key Ctrl+H. 

 Setup 
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1) Select Initialize Type. 

2) Select the System List to initialize. 

3) Click Transmit button to initialize. 

You must make certain Initialize Type is correct, before activating it.  Also, use the function 
with caution, because the data is deleted in this function. 

Dial-Up Connection 

Dial-Up Connection uses standard phone line to connect to a remote device for communication.  
External modems are required for each site at remote and host to connect by phone line. 

Also, Dial-Up Connection Management can be used to manage multiple location registration, and 
when needed initiate the location’s remote device and communication. 

Refer to chapter 8 (STARWATCH iTDC PRO I Dial-Up Communication) for detailed information. 

 Start 

Click Set up->System Management->Dial-Up Connection List or press shortcut key Ctrl+G. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Input Find Condition 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create fresh data.  Click Add button to add Dial-Up Connection area data through 
input screen. 

  

1) Click Add button, and the following screen appears. 
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2) Select Port No.  You can only select the port that was configured for Dial-Up Connection. 

3) Input Dial-Up Chain Name. 

4) Check mark Out Line if setup, and input Out Line No. 

5) Input Remote Phone No. connected to remote modem. 

6) Check mark Auto Dial-Up Connection if setup, and configure connection and disconnection time. 

When configuring Auto Dial-Up Connection, make certain that connection and disconnection 
time does not overlap in multiple location setup.  This will cause abnormal operation. 

7) Click Save button to save input data.  Click Close button to finish. 

In Dial-Up Connection, connection failure can be frequent depending on phone line and 
modem status.  This is a special characteristic occurrence, and if 2-3 reattempts are made 
normal connection is established. 

 Dial 

Dial can be used in Dial-Up Connection List, Add, and Modify screen, but we recommend use as 
possible in the Dial-Up Connection List screen. 
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1) Use Find to locate connection or select from Dial categories to connect.  Selected location is 
highlighted. 

2) Click Dial for connection attempt. 

 Hang Up 

 

1) Select current established connect location. 

2) Click Hang Up to disconnect. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
content. 
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1) Select data to Modify, then click Modify button. 

 

2) Click Save button after data is modified to save. 

3) Click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
data. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

Database 

Database menu contains functions for Company, Department, Title, Area Data, Map Management, 
User Management, Database Management, and Access Control Option.  It is recommended to input 
as possible all data, because they are used as basis in initial input data for Access Control and Time & 
Attendance. 

Company Definition 

Input company name using the system. 

 Start 

Click Database->Company List or press shortcut key Ctrl+L. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Input Company Code and Company Name as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears.  

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create fresh data.  Click Add button to add Dial-Up Connection area data through 
input screen. 

 

1) Click Add button, and the following screen appears. 

 

2) Input Company Code.  If using a registered code, it will not register and a code being used 
message is displayed.  Do not overlap the Company Code in use. 

3) Input Company Name. 

4) Click Save button to save and click Close button to finish. 
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 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
content. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Modify button and the following screen appears.  This screen is identical to register screen.  
Company Code cannot be modified in this mode. 

 

2) Modify data. 

3) Click Save button to save data then click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
data. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

Department, Title, and Access Type can be setup as identical process in Company 
registration.  Detailed instruction is omitted. 

Area/Floor Definition 

Area/Floor configuration is used for default data creation to distinguish access door, reader, and 
sensors by installed locations.  Multiple buildings can be designated by area, and the floors correlating 
to the area can be distinguished. 

 Start 

Click Database->Area/Floor definition or press Ctrl+P on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

1) Input or select Find condition. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specfic parameters, it will display the entire information 
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 Add 

Add is used to create fresh data.  Click Add to input data of area and floor through the input 
screen. 

 

1) Click Add and the screen below appear. 

 

2) Input area code.  If already registered code is used, it will not register, but only a fresh area code.  
Do not overlap Area Code. 

3) Input area name. 

Select floor then click Add button.  It will show up in Floor List window.  Repeat this procedure to 
add additional floors. 

4) If all the floors are added to the area, click Save button to save. 

5) Click Close to finish. 
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 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
content. 

Selected data is displayed as below figure in highlighted blue bar.  Selecting the Area will display 
the corresponding floors on the right hand side content. 

  

1) Click Modify button and the following screen appears.  This screen is identical to register screen.  
Area Code cannot be modified in this mode. 

 

2) Modify Area Name and data by Delete or Add function. 

3) Click Save button to save data, then click Close button to finish. 

 Delete 
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Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
data. 

Selected data is displayed as below figure in highlighted blue bar. 

Deleting the Area data will also delete the corresponding floor data. 

  

1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

Map Definition 

This sets the map of each floor using the area/floor as basis.  Door and sensor location can be 
designated on the map.  This lets the user see which location the event occurred by the setup of the 
map to be displayed automatically, when the event occurs at the time. 

 Start 

Click Database->Map Definition or press shortcut key Ctrl+R. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Input or select Find condition. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create fresh data.  Click Add to input data of new map through the input screen. 

 

1) Click Add and the screen below appear. 
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2) Input Map Code and Map Name. 

3) Select Area and Floor for the location to be implemented. 

4) Select Map File.  User can select file as bmp, jpg, wmf and can check the image file as shown 
above before applying. 

5) Click Save button to save data. 

 Map Item Setup 

This function configures access door and sensor for the setup area/floor location.  This sets the 
sensor and access door location to be displayed on the real map to check status of sensor. 

1) Click Map Item button. 
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2) The following screen displays. 
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The display of map setup is identical to real map in size.  Also, as shown above, the current map’s 
corresponding access door and sensor is displayed as an icon. 

The door and sensor icon of corresponding map area data is automatically displayed.  For a 
door, the setup of Reader/Door data during registration is inputted.  It uses this data as basis 
to display the icons automatically on the corresponding map. 

Sensor uses identical method to display the icons automatically, by setup of the In/Output 
Point setup. 

3) Use the mouse to click and drag the door and sensor icon to the desired location. (Hold down the 
mouse button to drag, and release the button to set) 

 

Locate the door and sensor icon with the mouse pointer, and the door and sensor name is 
displayed by tool tip.  At the bottom displays the iTDC panel connected to the current door and 
sensor, along with data including names and location. 

Use the above data as basis to control the location of door and sensor. 

4) If location is completed, then click (X) on the right hand corner. 

5) If location was changed, it will display the following message.  Click Yes button to save. 
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 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered  
content. 

Selected data is displayed as below figure in highlighted blue bar. 

 

1) Click Modify button and the following screen appears.  This screen is identical to register screen.  
Map Code cannot be modified in this mode. 
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2) Modify Data. 

3) Click Save button to save.  

4) Click Map Item button to setup location.  Once completed, click Close button to finish. 

5) Click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
data. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

User Definition 

This function registers the user to operate STARWATCH iTDC PRO.  For default value (admin) is 
registered in the program, and you can register additional user or change authority of existing user. 

 Start 

Click Database->User Management or press shortcut key Ctrl+S. 

 Add 

Add is used to create fresh data.  Click Add button to add new user through input screen. 

 

1) Click Add button and the following screen appears. 
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2) Input User ID.  User ID cannot be overlapped. 

3) Input User Name and User Password. 

4) Check mark Administrator option or not. 

Administrator option gives authority to Add, Modify, and Delete user.  Only the User who has 
this authority can perform these functions.  User with no authority can use allowed functions, 
but not the above functions. 

5) Click Save button to save then Close to finish. 

 Modify 

Modify is used to change existing data inputted.  Select data to Modify.  

Selected data is displayed as below figure in highlighted blue bar.  

 

1) Click Modify to see the above screen.  The Modify screen is equal to registration screen.  User ID 
cannot be changed. 

  

2) Modify data to change. 

3) Click Save button to save data. 

4) Click Close button to finish. 
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 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
data.  Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

 Authority Setup 

This function sets the authority of use for each function type.  User can only use functions with 
authority designation, and this function can setup entire function or parts of it. 

 

Authority Setup is categorized in menu type as shown above.  User can setup use authority under 
each sub menu category under main category. 

1) For use authority, check mark the item and if canceling use authority, uncheck mark item. 
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 All Authority Grant: Setup all authority at once. 

 All Authority Cancel: Setup all authority as cancelled. 

 Total Select:  Setup use authority of corresponding menu at once. 

 Total Cancel: Cancel use authority of corresponding menu at once. 

2) Once completed, click Save button to save. 

3) Click Close button to finish. 

Database Management 

Database Management describes the backup, restore, and database compact function of data in 
using the STARWATCH iTDC PRO.  Also, through backup, restore, and history, it gives out backup 
week cycle message from the last backup date.  This is setup by the user at alert interval. 

Refer to chapter 9 STARWATCH iTDC PRO I Maintenance and Management for detailed information.
  

Option 

Option lets the user activate additional functions on user setup.  User can designate event type 
database store and display of data, and setup a separate sound file for playing out the sound during 
an event occurrence. 

Also, when the event occurs, the setup of designated email recipient will send out the event occur 
status automatically.  

Also, sets the option of map display when some event occurs with connection to the map display. 

 Start 

Click Database->Option or press shortcut key Ctrl+U. 

 Event Status Handling Option 

This sets the whether or not to save Event Type database and to display event in Event Status 
screen. 
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1) Check mark the items for event occur display on monitor.  If display is not necessary, cancel 
check mark. 

2) Check mark the items for event occur database save.  If save is not necessary, cancel the check 
mark. 

3) Click Save button to save then click Close button to finish. 

4) Click Close button to finish. 

 

 Event Handling – Sound Option 

This designates sound file by event type.  Once implemented, when an event occurs the setup 
sound file plays through a speaker with sound card in PC alerting the event status. 
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  s 

1) Check mark the items for sound play during an event occurrence.  If sound play is not necessary, 
cancel check mark. 

2) Click Search button on bottom to find sound file.  Selecting the file displays in Select Sound 
(Alarm) window.  Right hand side window displays the matched sound file. 

Sound file can only be selected as wav. File.  To play the sound, a PC with sound card and 
speaker is required.  

3) Click Save button to save. 

4) Click Close button to finish.  

 

 Event Handling – Email Transmit 

This function sends out email up to 3 recipients when a specific event occurs that was setup.  
Email contains date of event, time, event location, and type of event as data. 

To use this option, the operating PC must be connected to a network.  

This can be used with onsite mail server at company, and requires POP3 support to use this 
option.  If POP3 is not supported, it will not work.  
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1) Check marks the items for mail transaction during an event occurrence.  If transaction is not 
necessary, cancel check mark. 

2) Input Mail Server (SMTP) address. 

3) Input Name and Email Address of up to 3 recipients. 

4) Click Save button to save. 

5) Click Close button to finish. 

 

 Event Handling – View Map 

If a map is setup, it will automatically display when a specified event occurs.  Here the event type 
map display presence is setup.  View Map Option needs to be setup to display map automatically. 
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1) Check mark the items for map display during an event occurrence.  If map display is not 
necessary, cancel check mark. 

2) Click Save button to save. 

3) Click Close button to finish. 

Access Control 

Access Control Management contains functions required for User Management.  Details regarding 
access are setup and user registered.  Setup data is transmitted to iTDC. 

Holiday Definition 

This function connects to Time Schedule to apply.  Time Schedule can be setup from Mon-Sun with 
designated time for each day.   

For this function, the holiday data needs to be initially setup.  Holiday Definition is to apply holiday to 
Time Schedule and transmit to iTDC to setup. 

 Start 

Click Access Control Management->Holiday Definition or press shortcut key F2. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information. 
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1) Input Holiday Code and Holiday Name as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create fresh data.  Click Add button to add holiday through input screen. 

 

1) The following screen appears after clicking Add. 
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2) Select Holiday Code.  (Holiday Code can be used from 01-10 giving 10 codes for use) 

3) Input Holiday Name to be saved. 

4) Select the corresponding date, and double click the date on the calendar or click >> button. 

5) If an exception is needed on a selected Holiday, select the corresponding date and double click or 
click << button. 

 

6) Click Save button to save data, and click Close button to finish. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
category. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Modify to see the following screen.  The Modify screen is equal to registration screen.  
Holiday Code cannot be changed. 

 

2) Modify the items to be changed. 

3) Click Save button to save data, and click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
list data. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

 Transmit 

This function is used to send the setup functions to the iTDC device for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Transmit button.  This will send the selected data to the corresponding Panel No for 
application. 
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During transmit, if errors do not occur, there are no messages.  This means the transmit was 
completed without disruption.  If an error does occur, detailed explanation is displayed in a 
message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
iTDC panel for problems. 

Time Zone Definition 

This function sets the access time as 24 hours or divided into 5 time sections within 24 hours.  These 
data is setup in Time Schedule as per day. 

 Start 

Click Access Control Management->Time Schedule->Time Code List or press shortcut key F3. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information.  

 

1) Input Time Code and Time Code Name as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

 

 

 

 

 Add 
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Add is used to create fresh data.  Click Add button to add work holiday through input screen. 

 

1) The following screen appears after clicking Add. 

 

2) Input Time Code. 

3) Input Time Code Name. 

4) Setup the time From/To for Time 1, Time 2, Time 3, Time 4, Time 5. 

For example, the screen below shows (Access granted 09:00-12:00 Sunday, 12:01-13:00 no 
access, 13:01-18:00 access granted) 
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5) Click Save button to save and Close button to finish. 

The section of time schedule is set up within 24 hours of a day. 

Namely, if you intend to set up for 24 hours without division of 24 hours of a day, you have to 
input 0000-2400 in 1st section. The rest section is set up as 0000-0000 automatically. 

If you want to divide and use 24 hours of a day, it is possible to divide as maximum 5 
sections. To divide hours is mainly used to control of access time and/or to work together with 
time schedule of input/output. 

Namely if you admit to access door at AM and don’t admit at PM, it is applied in this case. 
The division of time is needed, in case of application of Lock or Unlock of access door. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
content category. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Modify to see the following screen.  The Time Code List screen is equal to registration 
screen.  Time Code cannot be changed. 

 

2) Modify the items to change. 

3) Click Save button to save data, and click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
list data. 

Selected data is displayed as below figure in highlighted blue bar. 

 

1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 
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Timeschedule Definition 

This function uses Time Zone data to setup time schedule for each day.  It is applied to the user to 
control access time, and is connected to the In/Output Point time schedule. 

Time Schedule can create up to 15 codes, and time schedule within the codes are sent to the iTDC for 
activation.  Setup the time schedule needed. 

 Start 

Click Access Control Management->Time Schedule List or press shortcut key F4. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information. 

  

1) Input Timeschedule Code and Timeschedule Name as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create fresh data.  Click Add button to add Timeschedule through input screen. 
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1) The following screen appears after clicking Add. 

 

2) Select Timeschedule Code.  It will display only the registered codes.  Use one of the 15 codes. 

3) Input Timeschedule Name 

4) Select Timeschedule Code to apply to each day. 

5) Select Holiday Code to apply holiday, and if not used select Not Use.  If Holiday Code was 
selected, Timeschedule Code for holiday needs to be selected. 

Selecting the Timeschedule Code will display at the bottom screen location, current selected time 
range in hour format. 
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6) Click Save button to save. 

7) Click Transmit button.  This will send the selected data to the corresponding Panel No for 
application. 

8) Click Close button to finish. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
content category. 

Selected data is displayed as below figure in highlighted blue bar. 

 

1) Click Modify to see the following screen.  The Timeschedule List screen is equal to registration 
screen.  Timeschedule Code cannot be changed. 
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2) Modify the items to be changed. 

3) Click Save button to save data.  

4) Click Transmit button to send the selected data to the corresponding Panel No for application. 

5) Click Close button to finish. 

 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
list data. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

 

 

 

 

 Transmit 

This function is used to send the setup functions to the iTDC device for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Transmit button.  This will send the selected data to the corresponding Timeschedule Code 
for application. 

During transmit, if errors do not occur, there are no messages.  This means the transmit was 
completed without disruption.  If an error does occur, detailed explanation is displayed in a 
message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
iTDC panel for problems. 

Access Group Definition 

When multiple units of iTDC are operated, by using each access door connected to the system, you 
can create Access Group to register user in a group type to control access area as a whole or control 
as is. 

 Start 

Click Access Control Management->Access Right List or press shortcut key F5. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information.  
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1) Input Group Code and Group Name as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create fresh data.  Click Add button to add Access Group through input screen. 

 

1) The following screen appears after clicking Add. 
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2) Input Access Group Code.  Do not overlap this code. 

3) Input Access Group Name. 

4) Select Timeschedule to apply. 

5) Double click the Access Door from Available Access Door List, or click >> button to register and 
apply corresponding Timeschedule. 

Here the Timeschedule and Access Door work as a team to setup Access Group.  This 
means the access door and setup Timeschedule correspond to using the setup access door. 

6) Repeat the above method to register additional Access Group. 

Cancel Access Door by double clicking on selected door or click << button. 
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7) Click Save button to save data, and click Close button to finish. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
group category. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Modify to see the following screen.  The Access Group is equal to registration screen.  
Therefore, the Access Group Code cannot be changed. 

 
 
2) Modify the items that need changing. 

3) Click Save button to save the modified information.  Click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
data. 
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Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

Card Holder Management 

This function registers user ID card.  Also basic personal data is inputted to approve ID card, and 
related data is displayed and used as Find/Output data.  At the time of registration, Access Group and 
Time Attendance is setup also. 

 Start 

Click Access Control Management->Card Holder Management or press shortcut key F6. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Click Delete button.  The screen will appear.  Click Yes button to delete or No button to cancel. 

2) Input Company, Employee No, Name, and Card No as appropriate. 

3) Select Sort By and Sort Order. 

4) Click Find to make an inquiry.  If inquired result is available, the screen appears. 

 Add 

Add is used to create fresh data.  Click Add button to add user data through input screen. 

  

1) The following screen appears after clicking Add. 
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2) Input Employee No, Name, and Card No.  This input is a requirement.  Card No is the ID number, 
and depending on card type, the digits range from 8-10. 

Employee No must not overlap.  It is used as a key to identify user. 

Input 4 digits Password if using card+pw to authenticate.  If you do not input a password, the 
default value of 0000 is setup. 

3) Input user’s detailed information as basic data. 

4) Input Issuing and Expire date.  Putting a check mark on Auto Delete on Expired Date will delete 
the corresponding ID number. 

This software has the function of auto-deletion of ID number at the expiration date by 
transferring deletion order through communication after check expiration date in S/W. Namely 
it is processed only in case that program is being operated normally.  

But even though that program was ended, when it is operated again, registered persons who 
expiry date is set at former date than the date of PC and auto-deletion is checked are deleted 
automatically. 

In case that communication error is occurred, it may not be processed automatically, for that 
this function is done through the communication of program. 

5) Click Access Right tab. 

This is used to limit the access area on the user by selecting placed Access Group or selecting 
Individual Access Door to limit the access area. 
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In case that you limit the access through defined access group, choose defined access group 
and choose access group at the lower part. Then access door list is included in access group 
is indicated at the bottom. 

The setting of Individual access doors can be used at the access group setting mode in case 
that proper access group is not existed,  or in case that you want to make and set the access 
group directly. In this case select setting of individual access doors and select the time 
schedule in the same method with access group setting, after that, double click door is 
admitted working together this time schedule.. 

2) Select Time & Attendance tab. 

This is used to apply Time & Attendance by input of corresponding data.  Refer to chapter 6 
STARWATCH iTDC PRO I Time Attendance for detailed information. 
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Input Date Employed.  Input Retirement Date if that is the case.  For a user who is retired, cancel 
the time attendance by removing check mark in Apply Time & Attendance.  This option 
determines whether or not data is created. 

If selecting Apply Time & Attendance, user needs to select Work Time and Work Holiday. 

Work Time is applied per individual by using the Work Code setup. 

Work Holiday is applied per individual to calculate attendance on a holiday work. 

Work Time and Work Holiday needs to be setup initially through work in registration and work 
holiday registration. 

Refer to chapter 6 STARWATCH iTDC PRO I Time and Attendance regarding setup for Work 
Time and Work Holiday. 

Click Save button to save data. 

Click Transmit button.  This will send the selected data to the system for application. 

When it is transmitted, ID is registered only at admitted area as following the setting of access 
group. So if a lot of access areas are exited, it might take some time for transportation of data. 
And that in case of communication defect, transmission error or delay of time can be 
happened. 

And when the data is being transmitted, transmission status is indicated in the middle of 
screen. 

This function will be operated only for normal communication status so that if the 
communication is lost, then this function will not be operated properly.  
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 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
content list. 

Selected data is displayed as below figure in highlighted blue bar. 

 

1) Click Modify to see the following screen.  The screen is equal to registration screen.  Therefore, 
the Employee No cannot be changed. 

 

2) Modify items to change.  Modify Detailed Information, Access Right, and Time & Attendance.  
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3) Click Save button to save data. 

4) Click Close button to finish. 

If card no or access group data was modified, you need to retransmit the data. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
list data. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

2) Clicking Yes button will delete all ID cards in iTDC device.  Once completed, it will ask the user if 
the current data is going to be deleted from database in a message box. 

Clicking Yes will delete from database, and registered into Delete Management to be restored 
later. 



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

123 

 

3) Click Close button to finish. 

 Individual Transmit 

This function transmits the selected data to the iTDC device, and activates the setup functions.  
User is selected from the corresponding access group to be sent to the registered access door. 

  

 Batch Transmit 

This transmits the entire data through Find in means of Find Condition to the iTDC.  If find has no 
specific parameters, it will display the entire information.  In this case, clicking Batch Transmit will 
send entire registered data, but if specific parameter is used to Find, it sends the found result 
completely. 
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Deleted Card Management  

This function lets the user manage the deleted data from User Contents.  If later on the deleted user is 
to be reinstated, this function recovers the data to register user without having to input all over again. 

 Start 

Click Access Control Management->Deleted Card Management or press shortcut key F7. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.   



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

125 

 

1) Input Company, Employee No, Name, and Card No as appropriate. 

2) Select Sort By and Sort Order. 

3) Click Find to make an inquiry.  If inquired result is available, the screen appears. 

 Recover 

This is used to recover delete user data.  Use Find to locate or registered deleted user content to 
select data for recovery. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Select data to recover from Find or Contents. 

2) Click Recover button to begin. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
list data. 

Selected data is displayed as below figure in highlighted blue bar. 

 

1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 
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Visitor Management  

This function manages visitor access by means of temporary visit registration.  The visitor is 

issued a card with setup of access area, and expires the access with input of Expire date 

automatically. 

 Start 

Click Access Control Management->Visitor Management or press shortcut key F8. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information.  

 

1) Input Company, Name, Telephone No, and Card No as appropriate. 

2) Select Sort By and Sort Order. 

3) Click Find to make an inquiry.  If inquired result is available, the screen appears. 

 Add 

Add is used to create fresh data.  Click Add button to add visitor information through input screen. 
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1) The following screen appears after clicking Add. 

 

2) Input Company, Name, and Card No.  This input is a requirement and must be done. 

3) Input visitor information. 

4) Setup Issuing Date and Expire Date.  Expire Date activates the automatic deletion of visitor ID.  
This means if the Expire Date matches the current PC time, the ID is automatically deleted from 
the device through communication. 
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The function of auto-deletion of ID number at the expiration date is transferred deletion order 
through communication after check expiration date in S/W. Namely it is processed only in 
case that program is being operated normally.  

This function will be operated only for normal communication status so that if the 
communication is lost, then this function will not be operated properly. 

3) Setup visitor access area.  Select from the Access Group already in place.  This function needs to 
be registered initially. 

5) Click Save button to save. 

6) Click Transmit to register the ID to iTDC. 

7) Click Close button to finish. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
content category. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Modify to see the following screen.  The Visitor Management Modify is equal to registration 
screen.  Therefore, Company and Name cannot be changed. 



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

130 

 

2) Modify data.  You must Transmit, if Card No and Access Group is changed. 

3) Click Save and Transmit button. 

4) Click Close button to finish. 

 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
data. 

Selected data is displayed as below figure in highlighted blue bar. 
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1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

 Transmit 

This function is used to send the setup functions to the iTDC device for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 

 Selected data is displayed as below figure in highlighted blue bar. 
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1) Select from Visitor List. 

2) Click Transmit.   

3) Click Close to finish. 

View 

Access Door Status/Control 

This function lets the user monitor access door status in real time.  The icon status changes displaying 
in real time (Door Open, Door Closed, Lock, and Unlock) 

Also, the user can control Lock, Unlock of access door by location of (entire, area type, floor type, 
individual type door) 

 Start 

Click View->Door Status/Control or press shortcut key Ctrl+F1. 

 Control 

This is used to control door of (entire, area type, floor type, individual type door) 
 

 Lock (Entire): Entire doors are locked. 
 

 Unlock (Entire): Entire doors are unlocked. 
 

 Lock (Area): Selected area doors are all locked. 
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 Unlock (Area): Selected area doors are all unlocked. 
 

 Lock (Floor): Selected Floor doors are all locked. 
 

 Unlock (Floor): Selected Floor doors are all unlocked. 
 

 

 Lock : Selected door is locked. 
 

 Unlock: Selected door is unlocked. 
 

 3 sec Unlock: Selected door is unlocked for 3 sec. 
 

 5 sec Unlock: Selected door is unlocked for 5 sec. 
 

 10 sec Unlock: Selected door is unlocked for 10 sec. 
 

 

Access door 
control buttons 

The status of all access doors is 
showed as text. Able to control each 
door, once you click right button of 
mouse at access door.  

Access doors included appropriate area or floor 
as following the condition of area and/or floor are 
indicated.  Or the change of icon shows visually 
as following the status of doors. 
Able to control each door, once you click right 
button of mouse at access door.  
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Transaction Status 

This function displays normal and alarm events when an event occurs.  It lets the user check in real 
time the event status. 

 Start 

Click View->Event Status or press shortcut key Ctrl+F2. 

 Event Status 

This displays normal access events. 

 

 Alarm Status 
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This displays various alarm events.  It shows user misregistration event, timeschedule error, and 
other input/output events. 

Also, in the event of an alarm, there is an Admin acknowledgement function.  User needs to 
acknowledge alarm status.  If the alarm event was not checked, it will load into the alarm status 
when program is rebooted. 

The number of alarm status loaded into the program is 3000 listing the current as standard.  If 
the user does not check the alarm status when reaching this limit, the alarm status will not 
display again. 

 

 Ack All:  Acknowledge all alarm events currently displayed. 
 

 Ack : Acknowledge alarm event selected with a mouse. 
 

 Alarm Details: Acknowledge alarm event selected with a mouse can input details with 
Operator Comments.  Once the alarm details are completed, click Ack button to acknowledge. 
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Alarm Status is displayed in various colors depending on alarm event type.  Also, when the 
Admin acknowledges an alarm event, the event is displayed in black to check whether or not 
the alarm event was acknowledged. 

Report 

Card Holder List Report 

The registered user status in Card Holder Management can be outputted. 

 Start 

Click Report->Card Holder List or press shortcut key Ctrl+F4. 

 Print 

This function uses registered Card Holder data as basis to print Card Holder contents in 
agreement to Find Condition. 

 

1) Select Report Type. 

Door Access Reports simply print employee’s number, name, company, department, title, 
and access group. 

Door Access Detail Reports print user’s personal information and their photo images. (It 
causes system overload if access data has many lists with photo images to print them out or 
pre-vie. 
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2) Input Company, Employee No, Name, and Card No as appropriate. 

3) Select Sort By and Sort Order. 

4) Click Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

  

  

4) To obtain print out of this screen, click the Print button located in the top left hand side. 

 File Conversion 

Card Holder Report 

Card Holder Report(Detail) 
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All reports can be converted to variety of files.  It can be converted to PDF, HTML, and Excel file.  
These converted files can be sent out via Internet and email to another person. 

 

 Export To Excel:  Excel report file is created as appearing in print image. 

 Export To HTML:  HTML report file is created as appearing in print image. 

 Export To PDF:  PDF report file is created as appearing in print image.  You will need 
Adobe Acrobat Reader to view the PDF file. 

1) Click the button for the type of file conversion. 

2) The following screen will appear.  Input the file name and designate a folder location. 

  

3) Click Save button.  Depending on file conversion type, it may take some time to complete. 
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There are instances where it may take some time for the procedure to complete, depending 
on conversion file type and number of pages. 

PDF and Excel file conversion takes some time.  You will need to wait until the mouse’s 
cursor hourglass display is finished. 

4) Once conversion is completed, you can open the converted file to check file image. 

 

 

Opened converted to Excel file 

Opened converted to HTML 
file
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 Export 

This function is used to export specified file through Find data for storage. 

Clicking Export button can store data from Find in text and Excel file. 

 

1) Input Search Condition. 

2) Click Export button, and the following screen appears. 

Opened converted to PDF file 
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3) Input file location, name, and select file format.  Click Save button to save. 

 

Export in Excel format
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Delete Card Holder Report 

The reports from deleted card holder in Card Holder Management are searched and printed.  It 
searches and prints data registered in Delete Management. 

 Start 

Click Report->Deleted Card Holder List Report or press shortcut key Ctrl+F5. 

 Print 

This function prints the report of Deleted Card Holder List in agreement with registered deleted 
card holder data. 

Export in Excel format 
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1) Input Company, Employee No, Name, and Card No as appropriate. 

2) Select Sort By and Sort Order. 

3) Click Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

 

4) To obtain print out of this screen, click the Print button located in the top left hand side. 

 Export and Conversion 
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These functions are used identically to methods explained formerly. 

Event History Report 

This report is searched as normal access event data of date and time.  This data prints out all users’ 
access record through search.  Use appropriate condition to search and print.  

 Start 

Click Report->Event History Report or press shortcut key Ctrl+F6. 

 Print 

This function prints the report of stored access status data in agreement with search data. 

 

1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Click Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 
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4) To obtain print out of this screen, click the Print button located in the top left hand side. 

Alarm History Report 

This report searches and prints alarm event data.  All data related to alarm events are stored in 
database.  Using date and time as Find Condition, the alarm event status is searched and printed. 

 Start 

Click Report->Alarm History Report or press shortcut key Ctrl+F7. 

 Print 

This function prints the report of stored alarm status data in agreement with search data. 
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1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Click Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

 

4) To obtain print out of this screen, click the Print button located in the top left hand side. 
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Individual Type Access Door Report 

This report uses setup Access Group data in Card Holder Registration, as basis to print out data of 
individual type access area/door status setup.  

 Start 

Click Report->Individual Type Access Door Report or press shortcut key Ctrl+F8. 

 Print 

It will print out Accessible Door List By Person. 

 

1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Select Report Type. 

Defined Access Group & Individual Access Group report consists of designate access group 
setup data and individual door type list setup. 

Defined Access Group Only report consists of designate access group setup data. 

Individual Access Group Only report consists of individual door type list setup. 

4) Click Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 
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5) To obtain print out of this screen, click the Print button located in the top left hand side. 

Accessible Door List by Person Report  

This report uses Accessible Door as basis to search and print out corresponding access door applied 
to give user authority. 

 Start 

Click Report->Accessible Door List by Person or press shortcut key Ctrl+F9. 

 Print 

It will print out Accessible Door List by Person. 
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1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Click Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

 

4) To obtain print out of this screen, click the Print button located in the top left hand side. 
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Visitor Event List  

This function searches and prints registered visitors’ access event status data.  This data is stored in 
database and the user search and print this data using date and time as basis. 

 Start 

Click Report->Visitor Event List or press shortcut key Ctrl+F11. 

 Print 

It will print out Visitor Event List. 

 

1) Input Date(From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Click Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 
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4) To obtain print out of this screen, click the Print button located in the top left hand side. 

Last Access Event Report  

This report is based on Last Access Event data to locate the current site the user is at, using the event 
occurrence data to search and print out. 

This data when used with iTDC device Antipassback function can create accurate data, but if 
Antipassback is not used, the resulting data cannot be seen as accurate. 

 Start 

Click Report->Last Access Event Report or press shortcut key Ctrl+F12. 

 Print 

It will print out Last Access Event Report. 
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1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Click Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

 

4) To obtain print out of this screen, click the Print button located in the top left hand side. 
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Chapter 

7  Time / Attendance 
 

STARWATCH iTDC PRO I Time/Attendance 

This chapter explains STARWATCH iTDC PRO I Time/Attendance in detailed use 
instruction. 
 
Time/Attendance 

Time/Attendance contains basic data configuration to create each individual time and attendance 
information.  You can make inquiries to retrieve the information. 
You must configure this function to use Time/Attendance. 
 

Work Time Definition 

For Work Time Definition, work code is created to configure daily attendance, Saturday attendance, 
lunch hour, extension start hour, and next day standard hour. 

 
 Start 

 
Click Time/Attendance->Work Time Definition or press shortcut key Shift + F2. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
 

 
  
1) Select the Work Time Code and input Work Time Name as appropriate. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 
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 Add 

Add is used to create fresh data.  Click Add button to add work time through input screen. 

1) The following screen appears after clicking Add. 

 

2) Input Work Time Code (It must not be duplicated) 

3) Input Work Time Name. 

4) Configure each Time. 

Configure Lunch Out/In time.  This information will be used at monthly end category to deduct 
or include total time of lunch taken to calculate total hours worked. 

Overtime is described as work performed after end of work schedule. 

 

5) Once input is completed, click Save button to save data. 



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

155 

6) Click Close button to finish. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered work 
time category. 

Selected data is displayed as below figure in highlighted blue bar. 

 

1) Click Modify to see the above screen.  The Work Time List is equal to registration screen.  
Therefore, the Work Time Code cannot be changed. 

2) Modify the items that need changing. 

3) Click Save button to save the modified information.  Click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered port list 
data. 

Selected data is displayed as below figure in highlighted blue bar. 
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4) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 

cancel. 

 

Work Holiday Definition 

Work Holiday Definition function configures work holiday to exclude from total attendance calculation. 
 

 Start 

Click Time/Attendance->Work Holiday Definition or press shortcut key Shift+F3. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information. 
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1) Select the appropriate Holiday Code and Holiday Name. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create fresh data.  Click Add button to add work holiday through input screen. 

 

1) The following screen appears after clicking Add. 
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2) Input Work Holiday Code. (It must not be duplicated) 

3) Input Work Holiday Name. 

4) Input Work Holiday Date Name. 

5) Click the work holiday date twice or select the date then press >> button. 

 

6) From the Selected Work Holiday Date list, delete the date by double clicking or selecting date and 
clicking << button. 

7) Click Save button to save data, and click Close button to finish. 

 Modify 
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Modify is used to change existing data inputted.  Find data to modify or to change registered work 
holiday category. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Modify button. 

2) Click Modify to see the following screen.  The Work Holiday screen is equal to registration screen.  
Therefore, the Work Holiday Code cannot be changed, except the holiday date included in selected 
holiday code. 

 

Modify the items to be changed. 

3) Click Save button to save data, and click Close button to finish. 

 Delete 
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Delete is used to delete existing inputted data.  Find data to delete or to delete registered work 
holiday list data. 

Selected data is displayed as below figure in highlighted blue bar. 

.  

1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 

Work Type Definition 

Work Type Definition configures late, leaving early, absence, business trip into work type code. 

 Start 

Click Time/Attendance->Work Type Definition or press shortcut key Shift+F4. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information. 
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1) Select the appropriate Work Type Code and Work Type Name. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information. 

 

 Add 

Add is used to create fresh data.  Click Add button to add work type data through input screen. 

 

1) Click Add button, and the following screen appear.  
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2) Input Work Type Code. 

3) Input Work Type Name. 

4) Click Save button to save data. 

5) Click Close button to finish. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered work 
type list. 

Selected data is displayed as below figure in highlighted blue bar. 

  
 
1) Click Modify to see the following screen.  The Work Type Definition screen is equal to registration 

screen.  Therefore, the Work Type Code cannot be changed. 
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2) Modify Work Type Name. 

3) Click Save button to save data. 

4) Click Close button to finish. 

Work Type Code 01, 02, 03, and 04 is configured as default value for Normal, Late, Absence, 
and Holiday work.  This value cannot be modified or deleted. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered work 
holiday list data. 

Selected data is displayed as below figure in highlighted blue bar. 

  

1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

164 

Daily Data Management 

Daily Data Management creates data from individually configured work time and work holiday using 
present normal access event data.  This is called daily end data. 

 Start 

Click Time/Attendance->Daily Data Management or press shortcut key Shift+F5. 

 Create Work Data  

Create Work Data creates data from individually configured work time and work holiday using 
normal access event data.  The created data is differentiated from normal access event, and saved 
as a separate data. 

 

1) Select the From/To date for creating work data. 
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2) Click Create Data button to begin work data. 

If there is no data, it will display a message as no data.  If there is data, a progress bar is shown in 
relation to data creation progress. 

3) Once completed, click OK button to finish data creation. 

 Find Daily Work Data 

Find Daily Work Data is used to get relevant information pertaining to the inquiry when information 
is available.  It is used to modify existing data information to send out, or when incorrect attendance 
data is found. 
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1) Select the From/To date for creating work data. 

2) Sort by date, company, department, employee ID, name, and attendance type as appropriate. 

3) Select view format. 

4) Select as View Minute or View Hour to see late, absence, overtime, and special duty by attendance 
type. 

5) Click Find to make inquiry.  If result is found, the data is displayed. 
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 Abnormal Attendance Data Modification 

After performing work data, you can check the daily attendance result by inquiry.  If modification is 
needed, double click the result to open the modification screen. 

 

Click the data to be modified with double click 

1) Click the data to be modified with 2 clicks on a mouse.  It will activate the screen below. 

 

2) Entry Date, Employee ID, and Name cannot be modified.  Work In Date/Time, Work Out Date/Time, 
Late, Early Leave, Overtime, Extra Time, and Work Type can be modified. 

3) If No Update is selected, the work data performed once more will not update the modified data. 

4) If modification is completed, click Save button to save data. 
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5) Click Close button to finish. 

If the work-closing will be updated, event data is resorted by time & attendance setting value. 
But this will be available to update for event data when the modification date is the same of 
original entry date, otherwise it can not be update if the user check for invalid update when the 
all data closing.  

 

If modifying attendance data, you need to find the data results in minutes.  Otherwise, the data 
results in hour cannot be modified.  Find the data results in minutes to allow modification to the 
attendance data. 

Monthly work data uses Daily work data as basis.  If daily work data is modified, it will reflect to 
monthly work data. 

 Export 

This function sends out work data as text file or Excel file format.  The files exported can be used in 
other attendance and wage programs, or connected to an ERP system to be used efficiently. 

 

1) Click Find button to make inquiry. 

2) Click Export button, and the following screen appears. 
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3) Designate folder to save into. 

4) Input file format. 

5) Select text file or Excel file for export format. 

6) Click Save button to save file. 

If text file is selected for export, the following screen appears.  
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Monthly Data Management 

Monthly Data Management uses work data as basis to get total of individual type monthly attendance 
data. 

 Start 

Click Time/Attendance->Monthly Data Management or press shortcut key Shift+F6. 

 Create Data 

Work data is used as basis to create Monthly Work Data.  Work data’s monthly total data is created 
by individual type monthly total data. 

 

1) Select Monthly Work Data.  This data is calculated using time attendance option configuration as 
basis.  If configuring date as 25th end date, it will calculate from last month 26th up to selected month 
of 25th as end date. 

2) Click Create Data button begin data creation. 
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 Find Monthly Work Data 

This is used to find data created in Monthly Work Data. 

 

1) Select Month, Company, Department, Employee ID, and Name as appropriate. 

2) Select view option as View Minute or View Hour. 

3) Click Find button to begin Monthly Work Data inquiry.  If data is found, it will display in the screen. 
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 Exporting Monthly Work Data 

Monthly Work Data can be exported in same manner as Work Data.  It can be sent as text file or 
Excel file to be used in other programs. 

Yearly Data Management 

Yearly Data Management uses Monthly Data as basis to calculate total annual time attendance data for 
data creation.  Data to be created is agreed with Monthly Data. 

 Start 

Click Time/Attendance->Yearly Work Data or press shortcut key Shift+F7. 

 Create Data 

Monthly data is used as basis for selected year’s monthly total data to create time attendance data. 
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1) Select Year for yearly data. 

2) Click Create Data button to begin yearly work data creation. 

 

 Find Yearly Work Data 

       This finds the completed yearly work data through inquiry.  It is used to check yearly work data or 
exporting the data. 
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1) Select Year, Company, Department, Employee ID, and Name as appropriate. 

2) Select view option as View Minute or View Hour, then click Find button. 

If data is found, it will display as following screen. 

 

 Exporting Yearly Work Data 

Yearly Work Data can be exported in same manner as Work Data.  It can be sent as text file or 
Excel file to be used in other programs. 

Attendance Report (Individual/Daily) 

Individual/Daily Report is outputted using work attendance data as basis.  This report displays Start 
work, Finish work, Late, Leave, Absence, and abnormal attendance modified data. 

 Start 

Click Time/Attendance->Individual/Daily Report or press Shift + F8 on keyboard. 

 Find and Print 

Input Find Condition to print appropriate data.  Input the conditions in the top part of screen, and 
how the report will be printed can be seen at the bottom part of screen. 
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1) Select type of Attendance Report. 

Individual Attendance Report find is From/To date of individual type data.  Daily Attendance 
Report find is From/To date of daily type data. 

2) Input Find Condition. 

3) Click Print button.  If data is found, it will display how it will look when printed.  The following screen 
will appear. 

 

Individual Attendance Report
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4) To obtain print out of this screen, click the Print button located in the top left hand side.   

You can operate the buttons next to the Print to zoom, compress, view multiple pages, and other 
options through these icons. 

 File Conversion (Export) 

All reports can be converted to variety of files.  It can be converted to PDF, HTML, and Excel file.  
These converted files can be sent out via Internet and email to another person. 

 

Daily Attendance Report 

 Export To Excel:  Excel report file is created as appearing in print image. 
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 Export To HTML:  HTML report file is created as appearing in print image. 

 Export To PDF:  PDF report file is created as appearing in print image.  You will need 
Adobe Acrobat Reader to view the PDF file. 

1) Click the button for the type of file conversion. 

2) The following screen will appear.  Input the file name and designate a folder location. 

 

3) Click Save button.  Depending on file conversion type, it may take some time to complete. 

There are instances where it may take some time for the procedure to complete, depending on 
conversion file type and number of pages. 

PDF and Excel file conversion takes some time.  You will need to wait until the mouse’s cursor 
hourglass display is finished. 

4) Once conversion is completed, you can open the converted file to check file image. 
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Opened converted to Excel file 

Opened converted to HTML file 
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Opened converted to PDF file 

Attendance Report (Monthly/Yearly) 

Monthly/Yearly report can be printed using Monthly Data and Yearly Data as basis.  This report is total 
calculation of Monthly and Yearly work attendance data.  Through detailed report, Monthly report can be 
checked by individual type of 1 month time attendance. 

 Start 

Click Time/Attendance->Report->Monthly/Yearly Report or press Shift + F9 on keyboard. 

 Find and Print 

Input Find Condition to print appropriate data.  Input the conditions in the top part of screen, and 
how the report will be printed can be seen at the bottom part of screen. 
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1) Select Attendance Report type. 

Monthly Attendance Report uses as basis Monthly Work Data to display monthly attendance by 
individual type.  Monthly Attendance Report (Day by Day) displays one month attendance at 
once to check data. 

Yearly Attendance Report uses Yearly Work Data to display current time attendance, and the 
data is agreed with Monthly Attendance Report. 

2) Input Find Condition. 

3) Click Print button.  If data is found, it will display how it will look when printed.  The following screen 
will appear. 
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Monthly Attendance Report (Day by Day)

Monthly Attendance Report
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4) To obtain print out of this screen, click the Print button located in the top left hand side. 

You can operate the buttons next to the Print to zoom, compress, view multiple pages, and other 
options through these icons. 

 File Conversion (Export) 

All reports can be converted to variety of files.  It can be converted to PDF, HTML, and Excel file.  
These converted files can be sent out via Internet and email to another person. 

 

Yearly Attendance Report

 Export To Excel:  Excel report file is created as appearing in print image. 
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 Export To HTML:  HTML report file is created as appearing in print image. 

 Export To PDF:  PDF report file is created as appearing in print image.  You will need 
Adobe Acrobat Reader to view the PDF file. 

1) Click the button for the type of file conversion. 

2) The following screen will appear.  Input the file name and designate a folder location. 

 

3) Click Save button.  Depending on file conversion type, it may take some time to complete.  

There are instances where it may take some time for the procedure to complete, depending on 
conversion file type and number of pages. 

PDF and Excel file conversion takes some time.  You will need to wait until the mouse’s cursor 
hourglass display is finished. 

Work Options 

In Work Options, you can configure selection of monthly data end of day, and decide whether the lunch 
hour will be excluded or included from total work hour. 

 Monthly Data End of Day 

Monthly Data End of Day describes the end of date for month. 

For example, if monthly data end of day is selected as 25th end date, it will calculate from last month 
26th up to selected month of 25th as end date basis create this month data. 

If 0 is selected, the correlating month’s last date is automatically calculated. 

For example, if you calculate on March,  will calculate from 1 March to 31 March using daily data . 
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 Lunch Hour Exclude Configuration 

Configure whether lunch hour is included in total work hour. 

 

Select Except lunch time in Total Work Time, if lunch hour is excluded from total work time.  
Otherwise, do not select if including into total work hour.  

Click Save button to save time attendance option, then click Close button to finish. 

If Monthly Data End of Day is not configured, Monthly End is not activated. 
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STARWATCH iTDC PRO I TCP/IP Communication 

This chapter explains TCP/IP communication explanation, along with detailed 
configuration instruction and usage with STARWATCH iTDC PRO. 
 
TCP/IP Communication  

TCP/IP communication takes place of existing serial communication, by using the already established 
network to communicate with the iTDC device and program.  
 
TCP/IP communication method supported by iTDC is divided into 2 main types.  First, there is an internal 
module that can be used, and an external converter called Neteye1000S using TCP/IP. 
 
If using internal type, each iTDC panel needs one module and one fixed IP for communication.  For instance, 
if using 10 iTDC panels to communicate, it needs 10 modules and 10 fixed IP. 
 
If using external type, Neteye1000S  RS422 communication with TCP/IP communication from program to 
device can be networked.  It can connect 32 iTDC panel devices via RS422 for operation.  For instance, if 
using external type converter, each converter can connect 32 units (Optional 255 units).  In this case, one 
fixed IP is needed for the external TCP/IP converter. 
 

In Usage Case of External TCP/IP converter 

If using external converter, it can connect up to a maximum of 32 iTDC panel units.  In this case, the 
communication must be connected via RS422 method.  You can use RS232 or RS422 if external converter 
has only 1 unit of iTDC connected.  If this is the case, it is more convenient to use the internal module 
instead. 
 
Connection method for external converter in RS232/RS422 is a bit different in wire connection and Piano 
Switch. 

 
Communication via RS232 

RS232 connection must be done in the following.  Use a 9 pin female connector to the iTDC RS232 
communication as shown below. 
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 Connection 

iTDC cable 9 pin connector  
TXD #2 pin (RXD) 

RXD #3 pin (TXD) 

GROUND #5 pin (GRD) 
 

 Piano Switch Configuration 

 

Switch # Switch Status 
1 On(Down) 

2 Off(Up) 

3 On(Down) 

4 Off(Up) 

5 On(Down) 

6 Off(Up) 
 

Communication via RS422 

RS422 connection must be done in the following.  Use a 9 pin female connector to the iTDC RS422 
communication as shown below. 

 Connection 

iTDC 9 pin connector 
TX+  #2 pin (RX+) 

RX+ #3 pin (TX+) 

TX- #7 pin (RX-) 

RX- #8 pin (TX-) 
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 Piano Switch Configuration 

 

    

Switch # Switch Status 
1 Off(Up) 
2 On(Down) 
3 Off(Up) 
4 On(Down) 

5 Off(Up) 

6 On(Down) 
 
 

External Converter Configuration Program  

Using an external converter for TCP/IP communication requires a configuration program, along with an 
IP and some configuration processes. 

 Program Installation 

The CD provided contains LAN converter IP configuration and operation status check.  Install the 
program to configure the LAN converter IP from the PC. 

1) Locate the NetEye1000_Setup.exe file in the CD and click on it to begin installation. 
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2) Click Next button to move on to following step. 

 

 
 

3) Check the folder the program will be installed on to, then click Install button to begin. 

 

 

4) Once installation is completed, click OK button to finish. 

 IP Configuration 

Click Start->Program->NetEye1000 to run program. 
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Once programming is running, it will display the following screen showing all LAN converters 
connected to the network. 
 
The figure below shows 2 LAN converters connected. 

 

 

Each LAN converter needs to configure IP, Gateway, Subnet Mask, and Port.  From the above 
figure, selecting the converter to be configured by double clicking will display the following screen. 

 

 

 
 

User needs to configure the above categories with a value.  Modify the IP Address, Gateway, 
Subnet Mask, but leave the rest with default values. 

 

Category Setup Value 
Mode Server 

IP Address IP Address received from network(No Duplication) 

Gateway Gateway received from network 

Subnet Mask Subnet Mask received from network 

Port 5000 
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BPS 9600 

Parity N  one

Data bit 8 

Stop bit 1 
   
  Click OK button to finish configuration. 
 

In Usage Case of In

e needs to be inserted on to the iTDC main board.  It uses 1 

Internal Module

 communication requires a configuration program, along with an IP 
rocesses. 

 

uration and operation status check.  Install the 

1) Locate the file in the CD and click on it to begin installation. 

ternal TCP/IP Module 

f using internal module, the TCP/IP modulI
network line and 1 fixed IP per iTDC panel. 
 

 Configuration Program  

Using an internal module for TCP/IP
and some configuration p

Program Installation 

The CD provided contains LAN converter IP config
program to configure the module of IP from the PC. 

 

 
 

2) Click Next button to move on to following step. 
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3) Check the folder the program will be installed on to, then click Install button to begin. 

 

 

4) Once installation is completed, click Finish button to complete. 

 
 IP Configuration 

Click Start->Program->IGM7100tool->IGM_Cfgtool to run program. 
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1) Once programming is running, it will display the above screen. 

Click Find Board button to locate current connected boards. 

 
 

  
 

2) If the boards are found, it will display the message Finding complete.  The Board List on the left 
hand side displays the found board’s Mac address. 

3) Click OK button. 

 

 
 

4) Select the board to configure. 

5) Check the selected module’s IP, Subnet, Gateway, Speed, Parity, Data Bit, Stop Bit, Flow, and 
Listen Port then modify if necessary.  Also, you must use Server Mode for Mode Selection. 
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Category Configuration Value 
Mode Server mode 

IP Address IP Address received from network(No Duplication) 

Gateway Gateway received from network 

Subnet Mask Subnet Mask received from network 

Listen Port 5000 

BPS 9600 

Parity None 

Data bit 8 

Stop bit 1 
 

 

 

 
 

6) If configuration is completed, click Setting button to input the data configuration to the module.  
When finished, it will display a message Setting complete.  Click OK to finish. 

 
Software Configuration 

 

Port Definition 

Port Definition describes the PC connection to Serial and TCP/IP communication loop.  It supports up to 
99 ports, but depending on PC performance, memory, and OS resources, it may not be possible to use 
99 ports.  We recommend using adequate number of ports for operation. 

 Start 

Click Set up->Port Definition or press shortcut key Ctrl+A. 

 Add 

Add is used to create fresh data.  If adding additional ports, click Add button and input data in the 
following screen. 



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

194 

1) Click Add button, and the following screen appears. 

 

2) Select Comm Type as Serial Chain for Serial, TCP/IP Chain for TCP/IP and Dial-UP Chain for Dial-
Up as communication type. You must be select TCP/IP Chain. 

3) Input activity or description  

4) Input screen changes if TCP/IP Chain is selected. 

 

Input the IP Address from the external converter or internal converter for configuration. 

Input TCP Port No as default value 5000. 

Select Module Type as internal or external version. 

5) Click Save button to save inputted data, and click Close button to finish. 

Panel Definition 

Panel Definition describes iTDC board’s data configuration. 

Each iTDC device has its own communication address.  Data is configured in S/W to each address to 
communicate with iTDC.  Each iTDC can be configured with a variety of function options by sending the 
data for application. 

 Start 

Click Set up->Panel Definition or press shortcut key Ctrl+B. 
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 Add 

Add is used to create fresh data.  If adding additional panels, click Add button and input data in the 
following screen. 

 

1) Click Add button, and the following screen appears. 

 

2) Select Port No.  It displays only the Port No that was registered in Port Registration. 

3) Unregistered Panel No. List displays items not selected from Port No.  Select the Board No to be 
registered choosing and clicking >> button or double click the Board No to select, and it will show up 
on the right hand side Registered Panel No List. 

Panel registration must be done one at a time to setup. 
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It will register one panel number with its basic data for configuration.  Click Save button to 
complete the process. 

Repeat the procedure to add additional panels. 

4) Select Panel Type as iTDC. 

5) Select Door Type as 2 door, 3 door, or 4 door for operation. 

6) Input Panel Name.  This is a must in order to define the location, when an event occurs to a panel. 

7) Configure card memory.  Depending on card memory setup, the event memory is automatically 
setup.  Configure adequate amount of card and event memory. 

8) Default Panel value is optional.  It is not necessary for operation. 

9) Click Save button to save data. 

10) Click Close button to finish. 
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STARWATCH iTDC PRO I Dial-Up Communication 

This chapter explains Dial-Up communication explanation, along with detailed 
configuration instruction and usage with STARWATCH iTDC PRO. 
 
System Requirement 

Dial-Up communication requires some devices for operation.  It needs 2 modems for host and remote site 
connection. 
 
Modem must be an external version for use, and the ability to auto answer function (Namely, when the 
host calls the remote modem, it answers to make connection) 
 
The iTDC system supports the following modem, and as possible uses this modem.  Also, to have Dial-
Up communication, it requires making of a separate communication cable one for the host site and one 
for the remote site. 
 
• 3Com U.S Robotics 56K Fax External Modem 2 (Remote Site, Host Site) or NetComm 

(http://www.netcomm.com.au/) Roadster V92 External Modem 2EA  (Remote Site, Host Site). 
• Host, Remote Serial communication Cable 
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Dial-Up Communication Layout 

 

Modem Configuration 

Some configurations are required to setup the host and remote modem for operation.  Configuration for 
communication speed and auto answer function is required. 
 
To configure the modem, it needs the manual, driver, and modem cable included in the modem package. 
 
To configure the modem environment, it requires the Hyper Terminal included in Windows. 
 
If Hyper Terminal is not installed, go to Control Panel and open Program Add/Delete file to install the 
program. 
 

Host Modem Setup  

To setup the Host Modem, all you need to do is modify the communication speed using the driver and 
cable. 

 

 

 
Telephone Line 

Max32

RS232C Host Cable 

Host Computer 
(with  iTDC Access 
Control Program) 

RS232C Remote Cable 

Host Site 

Converter 
(RS422/RS232) 

Remote Site 



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

199 

 Communication Speed Setup 

This function is used to calibrate communication speed between iTDC device and modem to be 
equal.  When the modem is first installed, the speed value is setup at maximum speed.  However, 
iTDC speed is 9600BPS, so the modem speed needs to be setup as 9600BPS for configuration. 

1) Install the modem to Window 2000 or XP, and then install the driver for modem recognition. 

2) Go to Control Panel and select Phone and Modem file.  Click on modem properties and change the 
speed to 9600bps.  (After driver installation, the speed is automatically setup at 115200bps) 

3) Use Hyper Terminal to send Initialize Command (ATZ) to the modem, and check the message OK 
appears. 

4) Once the above process is completed, turn the power off and disconnect 
cable for setup completion. 

Remote Modem Setup  

To configure the Remote Modem, it needs the driver and modem cable included in the modem package 
to setup the communication speed and auto answer. 

 Communication Speed Setup 

1) Install the modem to Window 2000 or XP, and then install the driver for modem recognition. 

2) Go to Control Panel and select Phone and Modem file.  Click on modem properties and change the 
speed to 9600bps.  (After driver installation, the speed is automatically setup at 115200bps) 

3) Use Hyper Terminal to send Initialize Command (ATZ) to the modem, and check the message OK 
appears. 

4) Once the above process is completed, turn the power off and disconnect 
cable for setup completion. 

 Auto Answer Setup 

1) Use Hyper Terminal to send Initialize Command (ATZ) to the modem, and check the message OK 
appears. 

2) When OK message appears, input ATS0=1 and check the message OK appears. 

3) When OK message appears, input AT&W and check the message OK appears. 

4) Once the above process is completed, turn the power off and disconnect 
cable for setup completion. 
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Serial Interface Pin Definitions 

DB-25 DB-9 Circuit Function Signal Source 
Computer/Modem

1 - AA Chassis Ground Both 
2 3 BA Transmitted Data Computer 
3 2 BB Received Data Modem 
4 7 CA Request to Send Computer 
5 8 CB Clear to Send Modem 
6 6 CC Data Set Ready Modem 
7 5 AB Signal Ground Both 
8 1 CF Carrier Detect Modem 
12 - SCF Speed Indicate Modem 
20 4 SD Data Terminal Ready Computer 
22 9 CE Ring Indicate Modem 

 
Cable 

Dial-Up communication requires a separate making of a cable.  Host and Remote cable making process 
is different to each other.  Refer to the wire layout below for the procedure. 
 

Host Cable 
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Remote Cable 

 
 
Software Configuration 

Port Definition 

Port Definition describes the PC connection to Serial and TCP/IP communication loop.  It supports up to 
99 ports, but depending on PC performance, memory, and OS resources, it may not be possible to use 
99 ports.  We recommend using adequate number of ports for operation. 

 Start 

Click Set up->Port Definition or press shortcut key Ctrl+A. 

 Add 

Add is used to create fresh data.  If adding additional ports, click Add button and input data in the 
following screen. 
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1) Click Add button, and the following screen appears. 

 

2) Select Port No and it will indicate Port No not used. 

3) Select Comm Type as Serial Chain for Serial, TCP/IP Chain for TCP/IP and Dial-UP Chain for Dial-
Up as communication type. You must be select Dial-Up Chain. 

4) Input activity or description 

5) Select from Serial Chain tab, Comm Port, Speed, Parity Bit, Data Bit, and Stop Bit.  The default value 
is Speed 9600, Parity Bit None, Data Bit 8, and Stop Bit 1 for  

6) Click Save button to save inputted data, and click Close button to finish. 

Panel Definition 

Panel Definition describes iTDC board’s data configuration. 

Each iTDC device has its own communication address.  Data is configured in S/W to each address to 
communicate with iTDC.  Each iTDC can be configured with a variety of function options by sending the 
data for application. 

 Start 

Click Set up->Panel Definition or press shortcut key Ctrl+B. 
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 Add 

Add is used to create fresh data.  If adding additional panels, click Add button and input data in the 
following screen.  

 

1) Click Add button, and the following screen appears. 

 

2) Select Port No.  It displays only the Port No that was registered in Port Registration. 

3) Unregistered Panel No. List displays items not selected from Port No.  Select the Board No to be 
registered choosing and clicking >> button or double click the Board No to select, and it will show up 
on the right hand side Registered Panel No List. 
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 Panel registration must be done one at a time to setup. 

It will register one panel number with its basic data for configuration.  Click Save button to 
complete the process. 

Repeat the procedure to add additional panels. 

4) Select Panel Type as iTDC 

5) Select Door Type as 2 door, 3 door, or 4 door for operation. 

6) Input Panel Name.  This is a must in order to define the location, when an event occurs to a panel. 

7) Configure card memory.  Depending on card memory setup, the event memory is automatically setup.  
Configure adequate amount of card and event memory. 

8) Default Panel value is optional.  It is not necessary for operation. 

9) Click Save button to save data. 

10) Click Close button to finish. 

 

Dial-Up Connection 

Dial-Up Connection uses standard phone line to connect to a remote device for communication.  External 
modems are required for each site at remote and host to connect by phone line. 

Also, Dial-Up Connection Management can be used to manage multiple location registration, and when 
needed initiate the location’s remote device and communication. 

 Start 

Click Set up->System Management->Dial-Up Connection List or press shortcut key Ctrl+G. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Input Find Condition 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create fresh data.  Click Add button to add Dial-Up Connection area data through input 
screen. 

  

1) Click Add button, and the following screen appear 
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2) Select Port No.  You can only select the port that was configured for Dial-Up Connection. 

3) Input Dial-Up Chain Name. 

4) Check mark Out Line if setup, and input Out Line No. 

5) Input Remote Phone No. connected to remote modem. 

6) Check mark Auto Dial-Up Connection if setup, and configure connection and disconnection time. 

When configuring Auto Dial-Up Connection, make certain that connection and disconnection time 
does not overlap in multiple location setup.  This will cause abnormal operation. 

7) Click Save button to save input data.  Click Close button to finish. 

In Dial-Up Connection, connection failure can be frequent depending on phone line and modem 
status.  This is a special characteristic occurrence, and if 2-3 reattempts are made normal 
connection is established. 

 Dial 

Dial can be used in Dial-Up Connection List, Add, and Modify screen, but we recommend use as 
possible in the Dial-Up Connection List screen. 
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1) Use Find to locate connection or select from Dial categories to connect.  Selected location is 
highlighted. 

2) Click Dial for connection attempt.  

 

 Hang Up 

 

1) Select current established connect location. 

2) Click Hang Up to disconnect. 
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Chapter 

10  STARWATCH iTDC PRO I 
Maintenance 

 

STARWATCH iTDC PRO I Maintenance and Management 

This chapter explains instructions for optimized program use through proper 
management and maintenance. 
 
STARWATCH iTDC PRO I Database Maintenance and Management 

In using the STARWATCH iTDC PRO, it requires some management, especially ongoing database 
management.  As the database becomes larger, it needs thorough managing by the user.  Even if the 
data is few, database management is a requirement. 
 
The program running speed may become slower, as the database becomes larger, and abnormal closing 
of program may damage the database.  The user should maintain ongoing database compression, 
backup, or copy the files to optimize program use. 

 
Database Management 

Database Management describes the compression, backup, and restore function of data in using the 
STARWATCH iTDC PRO. 

 Start 

Select Database->Database Management. 

 Data Backup 

The advantage of this function is blocking the damage to the database, and improving the program 

performance through Data Backup.  After backup is completed, compress the database to improve 

the database speed. 
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1) Select the Event Data, Alarm Data, or Visitor Event Data for Backup Option. 

Safekeeping event data is a must, because it is used later on in reports and as original data for 
time attendance function.  Keeping the original data lets the user restore data in the event of data 
abnormality in time attendance and access control results. 

You can use Microsoft Access 2000 or XP to manage the access user and device data in 
addition to the above. 

2) Select the From/To of Backup Period Condition to define backup files. 

3) After database backup, check delete if deleting original data, and check compress if compressing 
original data. 

4) Click Backup button. 

 
 

5) Input file name and folder location to save in. 

6) Click Save button. 

 Data Restore 
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It is used to restore the backup data.  If original data was deleted during backup, specific period data 
is not found.  In this case, use restore function to restore the backup data into the existing database 
file. 

If restoring the same file twice occurs, it makes a duplication data.  Do not restore a file that was 
already restored. 

 

 
 
1) Select the data to be restored. 

2) Click File Open button. 

 
 
3) Locate the backup file folder and click Open button. 
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4) Click Restore button. 

 
 

5) Restore status is shown on the progress bar. 

 
 Backup Option 

Backup Option configures backup alert presence.  Each event type backup alert cycle can be 
configured in week units.  This alert cycle is based on last backup date.  When the user configured 
week is past, backup message is displayed. 
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1) To use Backup Alarm, check mark Backup Alarm Use/Unuse. 

2) Configure Event Data for Backup Alarm in week units. 

3) Configure Alarm Data for Backup Alarm in week units. 

4) Configure Visitor Event Data for Backup Alarm in week units. 

5) Click Apply button to save. 

When the configured reminder to backup occurs, it will display the following screen message. 

 
 

 Database Management History 

This function manages history of backup and restore activities.  Through this management, you will 
know when, who, and what did something to the database. 
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While using the existing STARWATCH iTDC PRO, if reinstallation is needed, it is recommended 
to have a copy of the existing complete database. 

Backup and Restore function is limited to the event data.  Therefore, it is recommended to have 
copy of complete database in a separate folder, if program is installed another PC or deleting the 
existing system and reinstallation is performed. 

Using Access Program to Manage Database  

The iTDC uses Access database contained in Microsoft Office 2000 and XP.  If Access program is 
installed in a PC with STARWATCH iTDC PRO I installed and operating, it can manage the database 
files directly by opening it.   

 Database Compress and Restore 

This function initiates Compress and Restore of database where it may be damaged, and database 
with frequent add and delete history.  In Restore, database file that may have been damaged due to 
abnormal closing of program in general can use this function, but if the damage is severe, restore 
may not be possible. 

This function is recommended in weekly basis, if frequent add and delete is done to the database.  It 
does not matter how many times this function is performed, so set the cycle at intervals of 1 week, 1 
month, and 3 month to initiate. 

  
1) Compress and Restore database file is opened using Access program. 

2) Click Tools->Database Utilities->Compact and Repair Database to initiate compress and restore 
function as shown below. 

 
 

When using the function of Compact and Restore, you need to make certain the STARWATCH 
iTDC PRO I is not running.   

If compacting database files in a server, or shared folder containing multiple user files, you need 
to make certain if anyone is opening the file that was selected for compact.  To compact Access 
database, sole authority is needed to open/initiate correspond database. 
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Chapter 

11  Multi Language Setup 
 

STARWATCH iTDC PRO I Multi Language Setup 

This chapter explains STARWATCH iTDC PRO I Multi Language Setup instruction. 
 
Using Multi Language Setup Program  

The iTDC Multi Language Setup Program is used to configure STARWATCH iTDC PRO I multi 
language support.  It is here the user configures the language preference, form, menu, drop down list, 
and message functions to input and modify data. 

 

Screen Layout 

Initiating the iTDC Multi Language Setup Program will display the following screen.  

Main window consist of left hand side menu and right hand side function types. 

 

 
 

Menu 

Function setting 

menu of multilingual 

setting program of 

iTDC  

 

 
Program Area 

The screen of function selected in 

menu is shown in program practice 

area. The functions users want is 

executed through this area  

 

Menu Layout 

Multi Language Setup Program menu, and its function types are the following. 
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 Set Language 

Configure language preference by character style. 

 Set Menu 

Configure language preference for the top part menu display. 

 Set Form 

Configure language preference for character in input/output on screen display. 

 Set Message 

Configure language preference for character in message display. 

 Set DropDown List 

Configure language preference for character in all Drop Down Combo display. 

 Set Etc 

Configure language preference for the remaining categories. 

 Exit 

Save configuration. 

 
Set Language 

Language configuration is setup of font for each language type. 
 

 Start 

Select Set Language from left hand side menu. 
 

 Setup 

1) Select language used in language category. 

 

2) Select Screen Font 
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3) Click Save button to save data. 

 
 

 
 

 
Set Menu 

Setup language preference for top part of menu. 
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 Start 

Select Set Menu from left hand side menu. 
 

 Setup 

Multi Language input screen display the following, and the Korean and English language can be 
seen.  Input the user’s language with English as the standard base. 

For example, if using User Define 1 language, input the language preference by looking at the 
English Row. 

 
 

Input the user’s language 
with English as the standard 
base. 

 The above input will display the following screen.  If all inputs are completed, click  
 Close button to finish.  Inputs are saved automatically without a separate save 
 function.  All user needs to do is input data. 
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As shown above, input the menu caption then select User Language 1 in iTDC 
program, and it will display the following screen below. 

 
 

 
  

Set Form 

Setup of characters displayed in all input/output screen display. 
 

 Start 

Select Set Form from left hand side menu. 
 

 Setup 

Multi Language input screen display the following, and the Korean and English language can be 
seen.  Input the user’s language with English as the standard base.  

For example, if using User Define 1 language, input the language preference by looking at the 
English Row. 
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Input the user’s 
language with English 
as the standard base. 

 
 
As shown above, input the form caption then select User Language 1 in iTDC 
program and it will display the following screen below. 
 

 
 

Set Message 

Setup of language message display in STARWATCH iTDC PRO. 
 

 Start 

Select Set Message from left hand side menu. 
 

 Setup 

Multi Language input screen display the following, and the Korean and English language can be 
seen.  Input the user’s language with English as the standard base. 
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For example, if using User Define 1 language, input the language preference by looking at the 
English Row. 

  
 

Message box display of Language: 1.Korean setup. 
 

Input the user’s language with English as 
the standard base.

 
 

Message box display of Language: User Language1 setup. 
 

 
 

Set DropDownList 

Configure language preference for input/output in all Drop Down Combo display. 
 

 Start 

Select Set DropDownList from left hand side menu. 
 

 Setup 

Multi Language input screen display the following, and the Korean and English language can be 
seen.  Input the user’s language with English as the standard base. 

For example, if using User Define 1 language, input the language preference by looking at the 
English Row. 
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Input the user’s 
language with English 
as the standard base.

 
DropDownList display of Language: 1.Korean setup. 
 

 
 
DropDownList display of Language: User Language1 setup. 
 

 
 

Set Etc 

Setup of language for default value input items. 
 

 Start 

Select Set Etc from left hand side menu. 
 

 Setup 

Initiating the Multi Language input screen will display the following.  Input language preference in 
CAPTION column using REF CAPTION as base.  A separate column for Etc is not available.  
These values cannot be setup due to fixed value setup in database.   

However, using REF CAPTION as base to modify the CAPTION column value, the fixed value of 
data language can be modified.   
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REF CAPTION cannot be modified.  This value is for reference to language modification.  The 
actual character displayed in program is the CAPTION column value. 

 

Input the user’s 
language with REF 
CAPTION as the 
standard base.

 
 
 

 

The modified details in iTDC Multi Language Setup Program is applied immediately without 
having to reboot the STARWATCH iTDC PRO.   

However, the current running screen needs to be closed and reopened to display the modified 
language. 
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Chapter 

12 
STARWATCH iTDC PRO I 
Additional Function 

Functions added to STARWATCH iTDC PRO I 
: Applied only to STARWATCH ITDC PRO I v1.08 or over.   

Add Functions 

 

Monitoring 

 Total monitoring on one screen  
- All in one screen display of event status, alarm status, user data of current event with photo, map 

showing location of event with icons, video image of the event, events sorted by door at the same 
time.  

- Real time door status display and control with door icon on the map, video record data listing and 
its play.  

 
•   Real time video monitoring and recording on access and alarm events  

- Real time video monitoring on the door with video devices. 
- Recorded video recording and play by event type. 
 

• Video monitoring on the map screen and map setting screen.  
- Camera icon setting playing its live view in order to find easily its location.. 
- Event location display on the map screen with live video. 
 

• SMS Service 
- Event data message service to mobile phone numbers  
- Message service option by event types. 

 
 
System management 

• Output definition  
- All the devices connected to the outputs of controllers can be defined by user.  

ex: Emergency door , Alarm, siren etc. 
 
• Output status display and control   

- Real time monitoring of output status and control  
 

• Batch transmission of system setting data by specific controller 
-  Useful to download controller system setting values at once in case of initial system setting or after 
initialization of controllers  
 

• Batch transmission of card holder data by specific controllers 
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- Useful to download card holder data at once in case of initial system setting or after initialization of 
controllers.  

 
• Bio readers of FGR006SR , FINGER006SR, FACE006 management  

- FGR006SR , FINGER006SR, FACE006 system setting 
- FGR006SR , FINGER006SR, FACE006 fingerprint template upload/download  

 
Time & Attendance management 
 

• Work schedule setting by day  
- Work in, Work out, Lunch, extra work time setting by day  
- Holiday setting by day  

 
Card holder management  

• Bio template upload/download 
- Upload/download of bio templates of card holders registered in bio reader  
 

• Extra port for card reader only for registration  
- Automatic card registration by card reading  
- Direct connection to PC  
 

• Extra fields for user to define  
-   Extra 10 user data field in the card holder management section besides basic card holder data field.  
- Data connection to ID Badging system  

 
• ID Badging integration 

- Pre-view of user card printing image 
- Interconnection of data base with ID Badging in pre-view screen 

 
 
 

A. Detailed description of functions added. 
Monitoring 

- Integrated monitoring on one screen  
- Live video monitoring and recording by event  
- Live video display on map setting screen and map screen  
- SMS Service 

o Integrated Monitoring Windows 
 

Display on one screen event status, map display, video image. 

 Start 

Choose  View->Event status-> integrated monitoring 

 Integrated monitoring window 
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Display current access 
person data 

Display current event location 
on the map with various icons 
and its video image   

Display alarm and access 
event list of specific door  
and recorded video data 
listing of specific camera  
녹화 목록을 나타냅니다. 

Display access event 
list  

Display alarm event 
list  

 

 

 

 Recorded video play  

It records video image by type of events according to user definition in condition that IDTECK web 
sever and CCD cameras are connected to the software.   

In case of an event occurrence, it records its video image and show the recorded video icon on the 
event list.     

In order to replay the recorded video, click the icon( ) on the event list.  
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Recorded video play icon 

    
   - Recorded video play window provides various options of video control 

   - Still vide cut image can be exported as an image file (JPG, bmp etc.) 

   - Recorded video can be exported as an video file(avi, etc) 

 

 

 

 

 

 Live video monitoring 

It display live video image by type of events as user define in case that IDTECK web sever and 
cameras are connected.   

In case that an event occurs, it display live video of the site where the event occurs and the live 
video icon( ) shows on event list. In order to view the live video of the site of the event, click the 
live video icon.   
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Live video icon 

- Users can adjust the size of live video window with screen size icon.  

- Users can control PAN/TILT/ZOOM (PTZ) in case of connection with cameras with PTZ function on 
the live video play screen. 

 

 Monitoring tap   

On the right side of map monitoring window, the monitoring tap provides various text information. 

Map list of places applied access control, access and alarm event list of specific door, recorded 
video image list of specific cameras. 

 

- Map list 

Users can choose a map to display on the map screen from their list.   
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- Event list 

It displays the access events of the door chosen on the map screen by users.  

 

-Alarm list 

It displays the alarm events of the door chosen on the map screen by users.  

 

- Recorded video image list 

It displays the recorded video images of the camera chosen on the map  
screen by users.  
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 Real time door status  monitoring  

It shows the door open/close status in real time by door icon on the map. 

 

 Door control 

Users can open or close doors on the map screen. On  the door icon, click right mouth button to 
control it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Live video monitoring and recording on event status monitoring window.  
 

Users can operate live video play or recorded video play on the event status monitoring window.  

 Start 

Click view-> Event status ->Event monitoring screen  
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 Event monitoring window  

 

Display alarm event 
list  

Icons of live video monitoring and 
of recorded video play 

Display access event 
list  

 

 Recorded video play 

It records video image by types of access or alarm event as defined by users in condition that video 
devices are connected to the site.. 

When an event occurs, it records its video image and shows recorded video play icon on the list.  
To play the recorded video, click the icon( ). 
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Video Record  
Icon 
 IcIcon 

    
   - Control image by image play button. 

   - Able to send still image in image file (JPEG file and etc.) 

   - Able to send recorded image in other image format files (AVI file and etc.). 
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 Play real time image 

Real time monitoring is possible with view camera when normal/alarm event occurs. 

Image pops up in the map when event is occurred. Also, real time view icon is popped in event list. 
Click the camera icon( ) in event list to play real time images. 

 

Real time image icon 

- Able to change image sizes with magnifying icon in real time image. 

- Able to control camera with real time image view when camera supports PAN/TILT/ZOOM (PTZ) 
functions  

 
 

o Monitoring images in Map setting and Map screen 
Able to control angle of camera while monitoring images in map screen when view devices are installed. 

 Start 

Choose  System->Map Setting-> Map Item 

 Camera set up in map screen 

Set angle of camera while monitoring images in map screen when view devices are installed. 

-  Move camera icon to the place where the door is located 
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- Real time view is possible by double clicking camera icon. 

     

Camera Icon 

Double click camera icon 

- Live video view is to show when camera icon is double clicked. 
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Move camera icon 

- In case of an event occurrence, its door icon blinks on the map and its live video window pops up 
if a camera and web server is connected to the door. 

 

 

Indicates where event is occurring and plays live 
video window 
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o SMS Service. 
Able to send event in SMS by using foreign SMS services. 

  

 Star 

Choose  Set Up-> SMS Definition 

 

* Warning * 
 
This function does not support usage of Korean Language Program. 

You must register at ipipi.com in order to obtain this service. Set the given ID and 

Password which you have received when registering ipipi.com. 

 SMS Set up 

Set up information on SMS server and receiver. 

  

Choose when using SMS function. 

Type in the information which you 
have received from SMS service 
company. 

Type in SMS receiver’s information by 
clicking Add button. 

 
 
 

 How to set SMS 

- SMS server registration 
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1) Choose SMS Active. 
2) Register information on server and user received from the SMS service providing company. 
3) Email Address is automatically stored as User name + Server name. 
 

- SMS receiver registration 

4) Register information on SMS receiver as below. 
a. Click Add button. 

 
b.  Type in name and number of the receiver.(including country code)  
c.  Click Save button then close to finish. 

 
- To delete SMS receiver 
 

5) Follow the instruction below when deleting SMS receiver. 
a.  Choose the receiver which you wish to delete from recipient list. 
b.  Click Delete button on the left. 

 
c.  Click Yes to delete. 

 
 
 

 Card Event set up (Option) 

Set up card event and information which you wish to send through SMS. When chosen event occur 
the information which you have set up will be transferred to the receiver.  
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Edit information on chosen SMS event. 

Choose event which you wish to send through SMS. 

Check when using SMS function. 

References for typing information in SMS.  
 
1) Choose Card Event Definition. 
2) Choose event that you wishes to send through SMS. 
3) In contents, edit information which you wish to send in occurrence of the event. 
4) Refer to below legend for editing.  
5) Click “save” to store information. 
6) Click “close” to finish. 
 

 Input/Output event set up 

Set up information and types of input/output events which you wish to send through SMS. 
When chosen event occur the information which you have set up will be transferred to the receiver.  
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Edit information on chosen SMS event. 

 Choose input/output event which you wish to send through SMS.
 

Check when using SMS function. 

 
1) Choose I/O Event Definition. 

References for typing information in SMS.
 

2) Choose I/O event which you wish to send through SMS. 
3) In Contents, edit information which you wish to send in occurrence of data. 
4) Refer to below Legend for editing. 
5) Click Save to store information 
6) Click Close to finish. 

 

System Management 

- Output set up function 
- Output status sign and control function 
- Transferring all system information per controllers  
- Transferring all system information per biometric readers 
- Transferring all data on users per controllers 
- Supports FGR006SR , FINGER006SR  
- Supports FACE006 

 
o Output Set Up  

Users can define all the type of devices connected to all the outputs of controllers.  

For example outputs can be set to be connected to emergency exit, alarm, or other systems depending 
on the user’s definition. 
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 Start 

Choose  System -> I/O set up -> Output interface function. 

 I/O Setup and transmit 

Once user choose port no and controller number, it shows current output setting information of the 
controller. Only those outputs essential for each door, as listed below, are not to be changed.   

- List of essential door related output that is unchangeable. 

Door Type 2 Door Type 3 Door Type 4 Door Type 

 
 
 

Set up 
unable  

output no. 

No.1 output – Lock
No.2 output - Alarm
No.3 output – Lock
No.4 output – Alarm 

No.1 output – Lock
No.2 output - Alarm 
No.8 output – Lock 
No.9 output – Alarm 
No.10 output – Lock
No.11 output – Alarm
 

No.1 output – Lock
No.2 output - Alarm
No.3 output – Lock
No.4 output – Alarm
No.8 output – Lock 
No.9 output – Alarm 
No.10 output – Lock
No.11 output – Alarm 

 

  
- Set up information 

Interface No. Output number to set up. Must check to set up. 
Output type Devices to be connected to the output. 
Exit Button In case of emergency door, choose which exit button input should activate the 

output. 
Door Contact In case of emergency door choose which door contact input should activate the 

output. 
OP Time In case of emergency door, set output operation time once exit button is pressed. 
Timeschedule Automatically output control based on time schedule once it is set.  

Choose types of Output 
. Emergency door 
. Alarm 
. Other outputs 

Choose Output 

Choose port no and controller ID number to 
see its current I/O setting. 

In order to operate output on a 
certain schedule, set a time 
schedule .  

In case of emergency 
door, choose the 
interface between exit 
button and door contact 
for emergency 
door(option).  

Choose location of the 
output device 

Output time for input should be
typed in seconds. 
(0 sec ~ 98sec, 99 for infinitive) 
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Zone Location where the output device is installed. 
Floor Floor where the output device is connected. 
Name Name of the device connected to output 

. 
- Set up process 

1) Choose the controllers address and its port address. 
2) Output connecting point : Choose the output connecting point  
3) Output type : Set up types of the devices connected to the output  
                                                                                        

 (Emergency door , Alarm , normal output) 
* When emergency door is the output contact point. 
4) Exit Button : Choose the input contact point of the Exit button when exit button is installed on the 

emergency door. 
5) Door Contact : Choose the input contact point of the Door Contact when Door Contact is installed 

on the emergency door. 
6) OP Time : when exit button is installed on the emergency door choose the time(second) of Exit 

button. (0 sec.~98 sec. 99 for infinitive) 
7) Timeschedule : Automatically controls in time when setting is done in output of timeschedule. 
8) Zone, Floor, Name: Type the information on connected device.  
9) Click Save to store data base.. 
10) Click Transfer button send to controller. 

 
o Output status indication and control. 

Real time check on output connected to controller(door, alarm, normal output). Also, remote control of 
output is possible. 

 Start 

Choose Status-> door status/control. 

 Check door status and control door 

Able to check door status in real time where door has been set up from Door/Reader and output 
contact point. Also, able to control lock device of door through program. 

 CANCEL (ALL) : Cancel all running output. 
 RUN (ALL) : Run all output. 
 CANCEL (AREA) : Cancel only chosen area of running output. 
 RUN (AREA) : Run only chosen area of output.. 
 CANCEL (FLOOR) : Cancel only chosen floor of output. 
 RUN  (FLOOR) : Run only chosen floor of output. 
 CANCEL (EACH) : Cancel chosen output.. 
 RUN (EACH) : Run chosen output. 
 Operation by time(sec.): Run out put for selected time. 

However, to check door/emergency door status, door contact must be installed. Otherwise it will 
only check the lock device. 
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- Door status 

  

- Door control : Click right button of the mouth on the screen where there is a door. Controls door by 
given situation.(lock, unlock, unlock for certain period) 

 

 

 

 To see alarm status and control alarm device 
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Able to see the status of alarm device which has been set up in the output contact point in real time. 
Also, alarm can be controlled through program. 

- Alarm status 

  

- Control of Alarm : Click right button of the mouse on the screen where there is Alarm  device. 
Controls alarm by given situation.(Alarm on, Alarm off, Alarm on for certain period) 

 

 To check and control normal output status. 

Able to see normal output devices which have been set up from the output contact point. Also, 
normal output can be controlled through program. 
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- Door status 

  

- Door lock control: Click the right mouse on the screen of door. 
   Runs chosen devices for door(lock, unlock, lock for certain period of time). 

 

 

o System Information Batch Transmission for Controller 
This is use to run information on system for transferring at once. Also, to install controller, choosing 
system and transferring information. 

 Start 
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System->System management->Transferring information->Choose controller tap. 

 Batch transmission for controller 

This is used for transferring information at once. 
 

 

Choose controller for 
batch transmission. 

Check the information that 
you want to transfer... 

Shows transforming data.

1) Choose controller for batch transmission form the system list. 
2) Chose the data to transfer. 
3) Click “transfer” to send the data to controller. 
4) The transferred data is shown on the result list as below.. 
5) If the transmission is failed follow the error message instruction. 

If there is no system information on the Data Base, transmit after registering information. For cause 
of communication error, try it again or check the communication. 

 
 

Batch Transmission of system information  
 

System setting and data transmission after initial installation and initialization of Biometric readers 

 Open 

System->System management-> Data Transmission-> Biometric Reader  

 Batch selection of Biometric readers 
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Select the readers 

Select the data to transmit 

The result of transmission is returned on this window 

 
1) Select the readers from the list 
2) Select the data from the list 
3) Click “transmission“ button 
4) The transmission result is returned on the window  
5) If the transmission is not successful, check the database and the communication status.. 

 
 
 
 
 
 
o Batch transmission of Cardholders’ data to the controller and the biometric reader 
 

 Open 

System->System management-> Data Transmission -> transmission to controllers  

 Batch transmission of Cardholders’ data  



 
 
 
 
 
 

STARWATCH ITDC PRO I™ 

246 

 

Select controllers or 
readers  

Select the data to transmit 

The result will be returned on the list

The result will be returned on this window. 

 
1) Select controllers or readers from the list 
 
 
 
 
 
 
 
 
 
 
 
 

 Data transmission 

Transmit cardholders’ information registered in program. Transmit data cardholders accessible to the 
selected system. 
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2) Select ‘’ the transmission of all registered cardholders’ data” 
3) Click  “Transmission”  button. 
4) Select  “ Yes” . 

 
 

5) Select transmission type. 

 
 

5-1) Transmission after initialization : click  “Yes” button 
Caution : All the card data will be erased before transmission.  
 

5-2) Transmission without deleting existing data : Select ‘No’  
Select transmission type. To delete and register the card data again, select “Yes”. To modify existing 
card data without deleting, select “No”. 

. 
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5-3) If you want to cancel the transmission, click ‘Cancel’ button. 
 
 

 Transmission of consecutive card numbers. 

Select the range of card numbers to transmit. It is very convenient to transmit the consecutive card 
numbers. 

Caution :  Cardholders being registered to the controller automatically gain access to all the 
doors connected to the controller. When being registered to the biometric reader, not biometric 
data but card number and pass word (default :0000) will be registered. Biometric data can be 
registered later on.  

     

6) Select “ Consecutive card number transmission” 
7) Set the card number range to register. Select company and group to register the data collectively. 
8) Click  “transmit” button. 
9) If the following message is given, select “Yes”. 
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10) Decide whether to register the data collectively to the database.  The data registered to the 

database will become the basic information. 

  
10-1) If the card number already exists, the following message will be given. 
    To modify existing data, select “Yes”. If not, select “No”  
     

       
 
11) Select  transmission type 

 
 

11-1) Transmission after initialization : Select ‘Yes’ 
Caution : All the card data will be erased. 
 

11-2) Transmission without deleting existing data : Select ‘No’  
Select transmission type. To delete and register the card data again, select “Yes”. To modify 
existing card data without deleting, select “No”. 

 
 

11-3) Select  ‘Cancel’ to cancel transmission 
12) The transmission result will be displayed on the list 
 

 
o FGR006(SR) , FINGER006(SR) . 

Biometric reader setting, operation and fingerprint management are feasible.  

 Open 

system->biometric reader setting 

 FGR006(SR) 

Click “Add/modify” button. Set the address of the biometric reader. To change FGR006(SR)’s 
setting values, save and transmit the changes. . 
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 FINGER006(SR) 

Click “Add/modify” button. Select the address of the biometric reader. To change FINGER006(SR)’s 
setting values, save and transmit the changes.  
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o FACE006(SR)  

FACE006(SR) setting, operation and face data management are feasible.   

 Open 

system->select “biometric reader” 

 FACE006(SR) 

Click “Add/modify” button. Select the address of the biometric reader. To change FACE006(SR)’s 
setting values, save and transmit the changes 
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- Functions of (FGR006(SR), Finger006(SR) 
 

Functions Description 
Reader Mode RF Only  

RF + Fingerprint , Face (PW)  
RF + PW + Fingerprint , Face  

Fingerprint Mode Dual Mode : to register 2 different fingerprints under a single ID (low recognition 
effectiveness)  
Single Mode : to register a fingerprint twice   

Adaptive Mode Use : to enhance the effectiveness of fingerprint recognition ( recognition process is 
comparatively slow. The red light of the module blinks while scanning) 
Not Use : Disable Adaptive Mode 

Identification Mode By Auto Match( fingerprint only )  
Use : allows you to obtain access by using a fingerprint only  
Not Use : Disable identification mode 

Output Mode 26 Bit Wiegand  
ABA Track II  

Output Type Transmit the recognition result through the separate line 
Normal : Only after successful recognition, the card number will be sent out 
Extension : after recognition, the card number is sent out and the result will be sent out 
through the separate lines (Ok, Error) 

Function Mode Registration Mode : to register fingerprints 
Reader Mode : normal fingerprint reading mode 

LCD Display Status : the recognition result will be displayed 
Card No : Card number will be displayed. 

Key Pad Use : enter the card number by Key Pad 
Not Use : disable Key Pad 

006P Use :  recognition process will be made by PIN without a card. 
Not Use : A card is needed in recognition process. 

Stand Alone This functions is not available by now. By default, set as “ Use “ 

 
 
 

Time & Attendance 
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- Establishing Work schedule  

o Establishing Work schedule 
The work schedule function is designed to apply different work schedules by day to each group of 
workers. The work schedule consists of arrival time, departure time, lunch time and night shift. It is 
designed to assign different holidays to each week.. 

 Open 

Time & Attendance -> work schedule definition. 

 Assign work schedule by day 

 

- instruction 
1) Enter work schedule code  
2) Enter the name of work schedule  
3) Fill in work schedule field at your discretion  
4)  Absence check function is not feasible for a holiday.  Overtime work is applied to the employee 

working on a holiday. 
     

4) batch application : If the work schedules are regular during the week, set the time 
and click “ batch application” button.  

 
 
 
 

Card holder management  
• 2 Men Operation 

- If Administrator Card and Visitor Card had been read to reader, 2 Men Operation function would 
have been registered Administrator Card and Visitor Card to open access door. 

• Personal Tracking 
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- Personal Tracking function monitors being permanently stationed passer at Access Control 
System. 

• Guard Tour 
- Guard Tour function register/manage patrolman card, patrol area and patrol time. 

And it manages to result according to patrol.  

A. Detailed description of added functions. 
 

System Management 

 
- Fire Group 
- Alarm Controller Arm/Disarm 

 
o Fire Group 

Set controller’s input point on fire signal.  
According to fire signal, Fire Group function sets up emergency (fire) exit.  
When fire signal occurs, set emergency (fire) exit will be open. 
In case of no set Fire Group, occurred fire signal will make open connected all access doors in system. 

- Fire Signal Definition 

Should set connected fire signal on controller’s input point to set Fire Group. 

 Start 

Set Up -> Input/Output Definition -> Set fire signal on  
connected input point  with fire signal selecting controller’s input point Definition. 

 Set up Input Point Definition  

Input/ Output Definition set up mutual operational relation to occur signal for specific output when input 
signal occurs. And Input/Output sets seconds if output signal operates for some time. 
In addition, when input signal occurs, type of input signal and text of indicated customized definition 
can set. 
According to setting door type of input/output controller, relational information about input/output 
signal conception by standard controller default value was created and saved automatically on 
database. 
On this account, user cannot need addition and deletion. In case of changing only some information 
about mutual occurrence relation, operation time, input point of input/output signal, user can modify 
and transfer. 

 

 Find 

In case of existing set information already, Find is used when you search data in accordance with 
condition using Find condition. Therefore Find is used when you modify existing data. 
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3)  You select condition in accordance with Port No. and Controller No. 

4)  You search clicking Find button. In case of existing found result, detail is indicated. 

 Modify 

To set by fire signal, you modify Input point which fire signal was inputted. 
And you select controller’s input point to modify. 
Selected data is indicated on selection.  
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8)  You click Modify button. 

 

9)  You select Area(Location), Floor(Location) information. If you select location which  
   input signal occurs, you can confirm which event occurred any location at event  
   occurrence. 

10)  Set input point’s type on ‘Fire’.  
   STARWATCH V2.00.00 recognizes selected input point to fire signal. 

11)  Input point name indicates showed text on event occurrence window when fire  
   signal occurs 

12)  From 1 to 15 output decides whether output separately operates or doesn’t  
   operate when corresponding input signal (fire signal) occurs.  
   Inputted value on output set time (seconds) that output operates. 

13)  In case of inputting 00s, corresponding output signal doesn’t occur.  
   When you input (select) from 01s to 99s range value, relative output as set   
   second as operates. 
   Access door can be open through controller by itself as well as STARWATCH 

14)  Save clicking a Save button. 

15)  Transmit to controller clicking Transmit button. 

16)  Finish clicking Close button. 

 

- Fire Group Definition 

When fire point occurs, Fire Group Definition appoints access door that will be open. 
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 Start 

Set Up -> Select Fire Group Definition.  

 Find 

In case of having set information already, Find is used when you search data in 
accordance with condition inputting find condition. 
When you modify existing data, Find is used. 
 
 

 

 

 

 Add 

Add is used when you generate new data. When you supplement Fire Group, you input data 
clicking ‘Add’ button on data input screen. 

 
12) Click ‘Add’ button. Then registration screen about Fire Group is showed. 
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13) Select fire point to register wished Fire Group. If fire point has set, fire point code is automatically 
allocated. 
 

14) If set fire point doesn’t exist, you can’t set Fire Group.  
Fire point code is order of port number, controller number and input point number. 
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15) When you input fire point signal, you select access door wished to open. 
Add to Fire Group clicking ‘>>’ button or cancel clicking‘<<’ button 

 

16) Save selected access door clicking ‘Save’ button. 

17) When signal occurs on fire point, set Fire Group access door will be open on fire point. 

 

 
o Alarm Controller Arm/Disarm 
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Alarm Controller Arm/Disarm is function to set/release boundary signal connecting Alarm Controller. After 
entering set/release code (2 digit) using reader (-RFK101 etc.) which sends 8bit Burst signal, you can 
set/release boundary signal if card has been read. 
When Alarm Controller Arm/Disarm sets, output operates according to set output. Although card 
make read all reader, output etc. don’t operate. Arm/Disarm card is only read. If you don’t use Alarm 
controller Arm/Disarm function, you can set general card 
to disable person. If set card on disable card is read, exit can be open as well as set output time in input 
point definition separately. 
 
- Controller Definition 

You should do boundary set/release on connected controller with alarm controller. 
You actively set Alarm Controller Arm/Disarm function and then do Arm code (2 digit) and Disarm code (2 digit). 
If you don’t set Alarm Controller Arm/Disarm function, general card can be used on disable person mode. 
 

 Start 

Set up-> Controller Definition. 

 Alarm controller connected setting, Arm number, Disarm number setting 

You set up Alarm Controller Arm/Disarm function. 
You set up Arm code and Disarm code. 
 

1) Select controller wished to set on controller contents. 
2) Click ‘Modify’ button.  

 
 

3) When connecting with alarm controller, you select Alarm Controller Arm/Disarm. 
If you select Alarm Controller Arm/Disarm, setting field of Use Arm/Disarm, Arm code and Disarm 
code will show. 

javascript:flink(%22person%22)
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Input usable 2 digits code on each mode. If card is read after pushing set code on keypad, 
Arm/Disarm will be activated. 
 

When setting Arm/Disarm mode, set output generates on Input/Output Point Definition. Besides it 
processes not to access about being read card through reader until reading Arm/Disarm card. 
 

 
- Input / Output Point Definition 

 When you set Alarm Controller Arm/Disarm, Input / Output Point Definition set output to operate. 
Classified by each reader of controller, you can set output according to Alarm Controller Arm/Disarm.  

 For example, when you set Alarm Controller Arm/Disarm on number 1 reader, it makes output of 
number 2 and 4 operate.  
Operation time setting is possible until 98 s from 01s.  

 Output of each reader doesn’t operate on 00s and means infinite operation on 99s. 
 If Alarm Controller Arm/Disarm doesn’t use, Input/Output Point Definition will be output about disable 
person.   

 
 Start 

Set up -> Input/Output Definition -> Input Point Definition 

 Output Definition by Arm/Disarm Mode Definition 

Set output to operate when setting Alarm Controller Arm/Disarm. 
If Alarm Controller Arm/Disarm hasn’t been set, it would be output about disable person card.  

 
 
1) Select Advance (Special ID) on Input/Output Point Definition contents. 
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2) After selecting part of wished output according to Alarm Controller Arm/Disarm setting, click ‘Modify’ 

button. 
Example) 
Input/Output Definition set up is window to set output at Arm/Disarm(Disable Person Mode) 
setting on 01 port and number 1 RF reader of 000 Controller. 

 
 

 

 
3) Set Board Output to operate at Arm/Disarm (Disable Person Mode) setting. Do about each output. 

Setting about Operation second is possible from 01s to 98s. 
Output doesn’t operate on 00s and operates infinitely on 99s. 

4) Save data clicking ‘Save’ button.  
5) Apply to controller clicking ‘Transmit’ button.  
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- Arm / Disarm Card , Disable Card Definition 

   Set card to operate Arm/Disarm Mode. If you set not to use Arm/Disarm Mode of controller, it will be 
set about disable person. 

 
 Start 

Access Control -> Card Holder Management 

 Arm/Disarm Card Definition 

Set card to definite Arm/Disarm Mode. 
 
1) Click ‘Add’ button on Card Holder List. 
2) Input card information to definite Arm/Disarm Code.  

(Be similar with Employee Card’s registration.) 
3) Select to Card Option tab.  

If you select to Arm/Disarm Mode in controller setting, Card Option will show as shown below. 

 
4) If you use registered card to Arm/Disarm Card, you must select to Arm/Disarm Mode. 
5) Save data clicking ‘Save’ button. 
6) Apply to controller clicking Transmit button. 
  

 Arm / Disarm Card Operation 

1) Arm: Read card after inputting setting code of Arm/Disarm Mode in Arm/Disarm setting reader 
(keypad reader usable of RFK101 etc.). 
According to Arm/Disarm setting, output operates and reader doesn’t read other card except 
Disarm Card.  

2) Disarm: Read card after inputting setting code of Arm/Disarm Mode in Arm/Disarm setting reader 
(keypad reader usable of RFK101 etc.). 
Arm Mode is released and output is operated according to setting. Reader reads all cards. 
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    ※ Caution: In case of Arm/Disarm Card, if you don’t input Arm/Disarm code, card will be used as 

Employee Card.  

 
 

 Disable Card Definition. 

Set Disable Card to operate output by setting time. 
 

1) Click ‘Add’ button on Card Holder List. 
2) Input information about Disable Person. (Be similar with Employee Card Registration) 
3) Select Card Option tab. 

If you don’t select Arm/Disarm Mode in controller setting, option button of Disable Person Card as 
shown below will show. 

 
4) If you use registered card to Disable Person Card, you must select Disable Person Card. 
5) Save data clicking ‘Save’ button.  
6) Apply to controller clicking Transmit button. 
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Cardholder Management 

- 2 Men Operation. 

- Personal Tracking 

- Guard Tour 

o 2 Men Operation. 
Register Management Card and Visitor Card to open access door when Management Card and Visitor 
Card are read in the reader.  
If Management Card and Visitor Card is read in the reader, it can function to open access door. 

 Start 

Access Control -> Card Holder Management 

 Management Card Registration 

Register Management Card to use in 2Men Operation. 

1) Click ‘Add’ button in Card Holder List. 

2) Input information about Management Card of 2Men Operation Card Holder Management screen. 
(Be similar with Employee Card’s registration) 

3) Move to Card Option tab. 
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4) Initial Card Option became Employee Card.  
Select ‘Management Card’ option to register 2Men Operation’s Management Card. 

 

5) Save data clicking ‘Save’ button. 

6) Transmit to controller clicking Transmit button. 
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 Visitor Card Registration 

Register Visitor Card to use in 2Men Operation. 

1) Click Add button on Visitor List. 

2) Input information about Visitor Card of 2Men Operation on Visitor Management 
screen. (Be similar with Employee Card.) 

3) Move to Card Option tab. 

 

4) Initial Card Option became only Visitor Card. Select ‘Visitor Card + Management  
Card’ to use Visitor Card of 2Men Operation.    
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5) Save data clicking ‘Save’ button. 

6) Transmit to controller clicking ‘Transmit’ button. 

 

 2Men Operation 

1) Make Management Card or Visitor Card read in the reader that is wished to access. 

 

 

2) After Being read first 2Men Operation Card, Management Card or Visitor Card is read within 5s. 
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3) If same card is read repeatedly or other card isn’t read within 5s, alarm about Time Out will occur. 

     
 

 
 
 
  
o Personal Tracking 

Personal Tracking monitors that access person has been stationed permanently. 

 Start 

Set Up -> Personal Tracking Reader Definition 

 Personal Tracking Reader Definition 
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Set IN and OUT Reader List in appointed space for check-in management.  

Can understand that check-in condition about read and entered access person 
through set reader by space’s IN Reader.  
Check-out is processed about read and went out access person through set reader to space’s OUT 
Reader. 

1) Execute on the reader’s registration about check-in management. 

 

2) In Available Reader List, select IN Reader of space that has been wished to check-in management. 

3) Select IN Reader List clicking ‘>>’ button. 
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4) In Available Reader List, select Out Reader of space that has been wished check-in 
management. 
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 Personal Tracking Report 

Finds/ Prints personal tracking report during check-in. 
Do leaving process about incorrect data too.  

1) Report -> Personal Tracking Report 

 

2) Click ‘Find’ button after you select Find Condition.  
And then it shows personal tracking report, final area and time during check-in.  
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3) If you want to print about Personal Tracking Report, you must click ‘Print’ button. 

     

4) If incorrect results come out real check-in condition differently, you can manage 
forcibly leaving process. You do leaving process selecting incorrect data and clicking ‘Yes’ button 
about inquiry that “Delete the data you select?”  

 

     

 

 

o Guard Tour 
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Register/Manage card, area and time of Guard Tour.  

Manage result according to Guard Tour. 

 Start 

Access Control -> Guard Tour 

 Guard Tour Definition 

Set employee, course and time etc. for guard tour. 

1) Access Control -> Guard Tour -> Guard Tour Definition 

 

2) Select Guard List tab on Guard Tour List. Click ‘Add’ button to register employee for guard tour. 

3) Select employee for guard tour among registered access persons. Add employee for 
guard tour clicking ‘Add’ button in Guard Tour List. 
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4)  Close to register employee for Guard Definition clicking ‘Save’ button. 

5) Select Guard Tour List tab on Guard Tour List window. Click ‘Add’ button to register course and 
time for guard tour. 

 

6) Select Guard Tour List tab on Guard Tour List window. 

7) Input Guard Tour Code and Guard Tour Name.  
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8) If order is appointed, option that ‘Sequenced Guard Tour’ will be selected. 
If you check option that ‘Sequenced Guard Tour’, you can appoint ‘Check Time’. And employee for 
guard tour should progress patrol fitting Check Time. 

 
8-1) In case of ‘Sequenced Guard Tour’, Set ‘Tour Time’. Set ‘Tolerance for Early Arrival’ and   
‘Tolerance for Late Arrival’.  

        For standard ‘Tolerance for Early Arrival’, Guard Tour Employee patrols more early than ‘Tolerance 
for Early Arrival’. 

For standard ‘Tolerance for Late Arrival’, Guard Tour Employee patrols more 
late than ‘Tolerance for Late Arrival’. 

 

9) After selecting ‘Selected Check Point’, register Area for Guard Tour clicking ‘->’ button. 

 

 

10) Save data clicking ‘Save’ button. 

 

 Guard Tour Status 

Use at real guard tour. Can start a guard tour and can see a guard tour list. 

1) Access Control -> Guard Tour -> Guard Tour Status 
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2) Select ‘Guard Tour Code’ that you wish to guard tour. 

3) Select ‘Guard Tour Name’. 

4) Start clicking ‘start a guard tour’. Selected person as guard tour employee makes card read in the 
reader which is selected as area for guard tour. 

 

5) If Guard Tour Employee patrols, Touring List and Detail Touring List will show on the screen. 
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6) If you cancel guard tour, you must select ‘Guard Tour’ wished to cancel in Detail 
Touring List. Cancel ‘Guard Tour’ clicking ‘Cancel’ button. Canceled Detail Touring List was not 
recorded. 

7) If guard tour is completed, you must select guard tour that is wished to complete in 
Detail Touring List. Complete guard tour clicking ‘Close’ button. Completed detail touring list can be 
confirmed in Guard Tour Report. 

※ Caution : If registered card for guard tour employee don’t try ‘start a guard tour’, 

it will be used as Employee Card. Only try to ‘start a guard tour’, it is recognized as guard tour. 

 

 Guard Tour Report 

Find about completed guard tour report 

1) Select Report -> Guard Tour Report. 

2) Select ‘Find Condition’. That is Date(From), Date(To), Guard Tour Code and Guard Tour Name etc. 
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3) Print ‘Guard Touring Report’ clicking ‘Print’ button. 
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